Trademarks

The Don Johnston logo and *The Leader in Learning Intervention Resources* are trademarks and Write:OutLoud is a registered trademark of Don Johnston Incorporated.

*IBM Independence Series Partner Solution* is an International Business Machines Corporation (IBM) owned trademark and is used by Don Johnston Incorporated under license. ViaVoice is a trademark of International Business Machines.


Write:OutLoud 3.0 Copyright © 1993-99 Don Johnston Incorporated. All rights reserved.

*Franklin® Electronic Publishers*


THE PROXIMITY/FRANKLIN DATABASE © 1997, Franklin Electronic Publishers, Inc. © Copyright 1998. All rights reserved, Proximity Technology Inc.

Write:OutLoud 3.0 UK Copyright © 1993-99 Don Johnston Incorporated. All rights reserved.

*Franklin® Electronic Publishers*

THE PROXIMITY/FRANKLIN DATABASE © Copyright 1990, William Collins Sons & Co. Ltd., © 1990. All rights reserved, Proximity Technology Inc.

THE PROXIMITY/FRANKLIN DATABASE © 1997, Franklin Electronic Publishers, Inc. © Copyright 1998. All rights reserved, Proximity Technology Inc.

Published by:
Don Johnston Incorporated
26799 West Commerce Drive
Volo, IL  60073

Printed in the United States of America, April 1999.
## Contents

### Introduction
- **Becoming a Writer** ................................................................. 5  
  - About this Manual ................................................................. 5  
  - Launching Write:OutLoud ..................................................... 6  

### Chapter 1
- **Using Write:OutLoud in the Classroom** ............................. 7  
  - The Writing Process ............................................................ 7  
  - Educational Benefits ........................................................... 8  
  - Sample Documents ............................................................. 10  

### Chapter 2
- **Using the Toolbar** .............................................................. 12  
  - Unique Talking Toolbar Features ....................................... 12  
  - Text Navigation and Selection Buttons ......................... 14  
  - Speech Buttons ................................................................. 16  
  - File Management Buttons ............................................... 17  
  - Content Buttons ............................................................... 18  
  - Appearance Buttons ......................................................... 22  

### Chapter 3
- **Using the Menus** ............................................................... 24  
  - File Menu ........................................................................... 24  
  - Edit Menu ........................................................................ 27  
  - Text Menu ......................................................................... 34  
  - Options Menu .................................................................. 37  
  - Speech Menu ................................................................... 41  
  - Windows Menu ................................................................ 46  
  - Help Menu ....................................................................... 47  

### Chapter 4
- **Write:OutLoud’s Talking Spell Checker and Talking Dictionary** ................................................................. 48  
  - Why Write:OutLoud’s Spell Checker and Dictionary Work ................................................................. 48  
  - Using the Franklin Spell Checker in Write:OutLoud ................................................................. 49  
  - Using the Franklin Dictionary in Write:OutLoud ................................................................. 51
Becoming a Writer

Welcome to Write:OutLoud, the easy-to-use talking word processor that guarantees writing success. Over the years, educators like you have told us that Write:OutLoud is the “must-have” word processor for students. We have added essential new features to support the writing curriculum to guarantee a greater rate of success for students who struggle with writing and reading.

Write:OutLoud lets the student see and hear what they are writing, helping them develop their writing and reading skills at the same time. Write:OutLoud is flexible so students can hear letters, words and sentences while they write. It can read a whole page and reread it as often as the student needs. Writing with Write:OutLoud enables students to express their ideas, often for the first time in their lives!

The easy-to-use interface enables students to work independently. The talking toolbar enables them to work without menus. Speech, text color and background color support the students’ visual and auditory needs. Students begin to increase their writing time and the amount of their writing.

After students express their ideas, Write:OutLoud helps them revise and edit their writing. The integrated Franklin® spell checker finds and corrects their spelling and capitalization errors. Students can look up word meanings in the Franklin Dictionary and use the Homonym Checker to select the right words. And, of course, Write:OutLoud makes the spell checker and dictionary talk, so students can hear their work, make corrections and make better word choices.

When the writing is complete, students have writing they are proud to turn in and display. Educators are confident that the portfolio samples written with Write:OutLoud truly reflect the writing and thinking ability of their students.

About this Manual

Before using this user guide, you’ll need to install the program following the instructions on the READ ME FIRST Install Card or the Getting Started booklet. Getting Started also provides information on main features, a quick tutorial and converting documents created with earlier versions of Write:OutLoud.

This Write:OutLoud User’s Guide provides detailed information about Write:OutLoud features and commands as well as suggestions and strategies for classroom use of Write:OutLoud. This manual is a reference tool for your everyday work with Write:OutLoud. This manual is also duplicated in an on-line format (PDF file) that you can read and/or print from your computer with Adobe Acrobat Reader (included with Write:OutLoud).
Chapter 1 discusses the writing process and the educational benefits of Write:OutLoud.

Chapter 2 reviews the features available in the Write:OutLoud toolbar.

Chapter 3 is an overview of all menu functions for Write:OutLoud.

Chapter 4 is a more detailed look at using the Franklin Spell Checker and Check Dictionary functions.

Chapter 5 is a more detailed look at adding pictures to your Write:OutLoud documents.

Chapter 6 includes Application Ideas and other tips for reading and writing with Write:OutLoud.

Appendix A is a complete list of key equivalents for Write:OutLoud.

Appendix B lists all abbreviations that Write:OutLoud recognizes as words.

Appendix C lists Discover Setups that are included with Write:OutLoud.

Appendix D includes problem-solving tips and frequently-asked questions for Write:OutLoud.

**Launching Write:OutLoud**

To begin using Write:OutLoud, launch it the way you would start any application:

![WriteOutLoud v3](image)

**Windows 95 and 98**

1. Click Start.
2. Click Programs.
3. Click Write:OutLoud in Programs.
4. Click the Write:OutLoud icon.
5. The program loads and you’re ready to begin typing.

**Macintosh**

1. Open the Write:OutLoud folder.
2. Double click Write:OutLoud application icon to launch the program. An untitled document appears.

Tip: For extra convenience, make a shortcut (Windows) or an alias (Macintosh) for the Write:OutLoud application and keep it on the desktop or other location for easy access.
Chapter 1

Using Write:OutLoud in the Classroom

Write:OutLoud has been designed specifically for students who struggle with writing. Listening to words as they are typed encourages reluctant writers and helps eliminate their frustration and reluctance. Auditory support is also critical when students are revising for sentence structure and meaning. Write:OutLoud give students the satisfaction and success that motivates them to write more and more.

The Writing Process

Students need to write often and for a purpose. Teachers must provide the reason for writing. Teachers and/or other students may be the audience for the writing.

There are five basic steps in the writing process. Here are some of the ways that students can use Write:OutLoud to support writing:

1. **Planning and organization**
   Students can use a scaffolding template in Write:OutLoud or an idea organizer like Inspiration to plan their writing.

2. **Composition**
   Students express their ideas in Write:OutLoud. Pictures can be added to support the text.

3. **Revise for mechanics**
   Students can correct spelling, capitalization and punctuation errors by using the auditory and visual cueing for misspelling as well as the talking spell checker.

4. **Revise for meaning**
   This means that students can revise their writing by telling it better, making it clearer, restructuring and rearranging language. Students can use the cursor navigation to read text, use the word-by-word highlight to review, and use the dictionary and homonym checker to make better word choices.

5. **Produce a product**
   Alignment, line spacing options, font and color features lets students change the look of their documents before or after editing them. Students can easily save and print their completed assignments.
Educational Benefits

Every feature in Write:OutLoud has been included to have specific educational benefits. It is simple and easy to use, yet powerful enough for classroom writing activities. Here are some examples:

<table>
<thead>
<tr>
<th>Write:OutLoud Feature</th>
<th>Educational Benefit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Talks while students write</td>
<td>Hearing and seeing text at the same time supports the composition step in the writing process. Students get immediate auditory feedback so they can hear if their text sounds right. This is a powerful, natural strategy for hearing where changes are needed. It is also very motivating for students to hear their progress.</td>
</tr>
<tr>
<td>Highlights word by word as it reads</td>
<td>Supports the composition and revision steps in the writing process. Enables students to connect the spoken and the written word and helps students edit for meaning.</td>
</tr>
<tr>
<td>Reads text files copied from the Internet or scanned from print</td>
<td>Students can read text independently. Hearing and seeing the text increases reading comprehension and reading fluency. Choose to have all text spoken for student or let student highlight unknown words and click Speak for audio support on individual words.</td>
</tr>
<tr>
<td>Franklin Spell Checker shows questioned word in context</td>
<td>Enables students to review the sentence for the contextual clues that will help them make spelling corrections. Students can listen to how words are pronounced and spelled.</td>
</tr>
<tr>
<td>Franklin Dictionary and Homonym Checker with Write:OutLoud speech features</td>
<td>Students can review whole sentences or look up individual words independently to check for spelling, word meanings and homonyms. Students can listen to how words are pronounced and spelled. Students select the correct words and improve the quality of their writing. Students can look up words for better reading comprehension.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customizable speech options</td>
<td>Students can get the kind and amount of auditory feedback they need to monitor their writing.</td>
</tr>
<tr>
<td>Choose voices for speech</td>
<td>Pitch, intonation, voice and speed affect how we process and comprehend what we hear. Students can use the voice that best supports their auditory processing needs.</td>
</tr>
<tr>
<td>Cross-platform file format</td>
<td>Enables students to take their work from class to class or between home and school.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Use a PC-formatted disk. Make sure PC Exchange or similar feature is enabled on Macintosh computers.</td>
</tr>
<tr>
<td>Save files as text-only</td>
<td>Text documents can be written and edited in Write:OutLoud and imported into other applications for more sophisticated formatting or usage. Text-only files can be read by most word processing and page layout applications.</td>
</tr>
<tr>
<td>Speech feedback</td>
<td>Students can work more independently because they get immediate feedback. So they write more and spend more time writing.</td>
</tr>
<tr>
<td>Easy-to-use toolbar with commonly-used features</td>
<td>Students can work more independently because they can make changes without using confusing menus or dialogs.</td>
</tr>
</tbody>
</table>
Sample Documents

A number of sample files are located in the Sample Documents folder which was installed within your WriteOutLoud folder. Examine the files for ideas on how to use the program or use the files as templates. Sample documents included are:

Math
► Estimates
► Hotel Facts
► Hotel Problems
► Menu Math
► Number Theory Review
► Word Problems

Music and Songs
► Clyde Sing Along
► Wheels on the Bus

Poetry
► Animal Crackers
► Brown Bear
► Casey at the Bat
► Eensy Spider
► Ghost Who’s Lost_Boo
► Jabberwocky
► Macbeth Witches Song
► The Raven

Reading
► E-Eater Machine
► Pledge of Allegiance
► Sleepy Hollow
► Telephone Etiquette

Recipes
► Bumps on a Log
► Fruit Salad
► Yogurt Smoothie
Science

- Circulatory System
- First Aid
- Quiz-Mass
- Quiz-Planets

Social Studies

- Continents
- Test of US Capitals

Spelling

- Find the Rhymes
- Phonics-AT family
- Rhyming Riddles
- Short E, Long E
- Spelling October words

START-to-FINISH Book Reports

- Alcatraz, The Rock
- Crossbow Killer
- Grave Robber
- Huck Finn
- Red Badge of Courage
- Treasure Island

Writing

- Bio-Poem
- Dinosaur Dossier
- N is for Name
- Party Invitation
- Silent Snake Actions (verbs in a different color)
- Silent Snake Animals (animals in a different color)
- Social Values
- Time Capsule

These sample files are saved as templates. You can create customized documents for use as templates, too. See Saving Option Settings in Chapter 6 for more details on how to do this.
Chapter 2
Using the Toolbar

Write:OutLoud is a talking word processor that is filled with features that increase its ease of use. Many functions can be carried out by simply clicking the toolbar at the top of Write:OutLoud window. This section helps you understand the features unique to Write:OutLoud, including navigating through text, speech options, spell checker and more.

Unique Talking Toolbar Features

When you launch Write:OutLoud, you’re ready to type and create documents immediately. The Write:OutLoud toolbar gives you one-click access to common tasks.

The buttons on the toolbar are grouped according to tasks for easier use. It’s also a talking toolbar. To hear a button speak its function, place the mouse pointer over the button. Windows users, click the Right Mouse button. Macintosh users, speech is automatic after your cursor stays on a button for a second or two. Also, a label that lists the button name pops up from the button.
Tip: If you do not want to hear the buttons speak their functions, turn Speak Toolbar off in the Options menu.

To try all the features you can access from the toolbar, type a few sentences in the Write:OutLoud window. You hear Write:OutLoud speak as you go. At the end of the sentence, it speaks the entire sentence, highlighting each word as it reads.

**Note:** See Appendix A for a complete listing of key equivalents for toolbar functions.

If you do not want to see the toolbar display, select Hide Toolbar from the Options menu.

Write:OutLoud document with toolbar hidden
Text Navigation and Selection Buttons

Tools for text navigation and selection help students quickly and efficiently move through and review their writing. Write:OutLoud includes four in the toolbar.

These tools are especially helpful for students with poor visual and/or motor skills. There are many more keyboard shortcuts for text navigation and selection; see Appendix A for a complete list.

Beginning

To move your cursor quickly to the start of the document, move your mouse pointer to the toolbar and click Beginning. The cursor moves to the beginning of your text entry.

Students can quickly get back to the beginning of the document to add a title or reread the story.

Move

To move your cursor to the next sentence, click Move. The cursor moves to the beginning of the next sentence. A sentence must end with a period, question mark or exclamation mark in order for Write:OutLoud to recognize it as a sentence.

Students can quickly navigate through their document for reading and revising the story.
Select
To highlight the next sentence, click Select. With the sentence highlighted, you can click Speak, Grow or Shrink Selection. If your cursor is in the middle of a sentence, Select highlights words from the cursor to the end of the sentence.

Students can quickly select “chunks” of text for reading aloud, revising or formatting, sentence-by-sentence.

End
To move directly to the end of the document, click End. The cursor moves to the end of your document.

Students can quickly get to the end of the document to add to existing work.
Speech Buttons

Speech feedback is important for writing success because it gives students immediate aural reinforcement of what they just typed. It gives students the opportunity to self-correct based on what they hear. Write:OutLoud includes three basic speech tools.

**Speak**

Click Speak to hear the sentence. Write:OutLoud speaks the selected text or the sentence containing the cursor.

Click Speak again and the next sentence is spoken. With this feature, you can move through your entire document sentence-by-sentence, speaking each as you go.

**To speak specific words or sentences**, highlight the text first, then click Speak.

**To speak the entire document**, choose Select All in the Edit menu and click Speak.

**Note:** For speaking, sentences are spoken until sentence-ending punctuation or new paragraphs are encountered.

Students can control reading of their document for comprehension or revision.

**Tip:** For story narration, the user can speak the document sentence-by-sentence and have control over the rate of storytelling. Place the cursor at the beginning of the file. Click Speak and the first sentence speaks. The cursor advances to the next sentence. Click Speak when ready. For smoother delivery, turn off Highlight Word by Word in the Speech menu.
Repeat

Click Repeat to hear again what was just spoken.

Students can repeat what was just heard to increase comprehension or when proofreading their work.

Stop

Click Stop to stop the current speech.

Students can immediately interrupt speech for any reason: to revise their work, work quietly, end a work session, make a different selection, etc.

---

Write:OutLoud includes many more speech options that you can turn on and off to meet students’ needs. See Chapter 3, The Menus, for more information.

---

File Management Buttons

It’s important for students to feel in control of common tasks. Our Save and Print One buttons give them easy access to these functions.

Save

Click Save to save your file to disk. The first time you save it, give it a name. This function is the same as selecting Save in the File menu.

Print One

Print One automatically prints one copy of your document, bypassing the regular print dialog. Click Print One to send the document to the printer. Print One gives students simplified access to printing—there are no additional windows to navigate through.
Content Buttons

Students who struggle with writing often don’t write very much text because of poor vocabulary, spelling or organization. Write:OutLoud’s Content features help students with editing for mechanics, revising with better words and using pictures to support their content.

Check Spelling

Click Check Spelling from anywhere in the document to begin the Franklin Spell Checker. Write:OutLoud always checks the entire document for spelling errors.

Write:OutLoud displays the Spelling dialog when it finds a word that is not in either the regular Franklin or user dictionaries.

The spell checker displays the sentence containing the unknown or misspelled word (highlighted) along with suggested known or correct words. Write:OutLoud makes the spell checker talk so you can hear the word in question spelled out and spoken in context and to hear other suggestions in its place. If the word in question is really a correct word or proper name, you can add it to the WOL User Dictionary by clicking Learn.

When you are finished with the spell checker and want to return to the document, click OK. All spelling changes are in the document.

For more information on using the spell checker, Chapter 4, Write:OutLoud’s Talking Spell Checker and Talking Dictionary.
Check Dictionary

Check word meanings with the Franklin Dictionary and Homonym Checker. Select the word you want to check and click Check Dictionary. If you don’t select a word, Write:OutLoud checks the word you just finished typing.

Write:OutLoud displays the Franklin Dictionary and Homonym Checker with the sentence that includes the word you are checking in the first window. The word meanings are displayed in the second window and homonyms or confusables, if any, are in the third window.

Use the dictionary to hear the word in question spelled out and spoken in context and to read and/or hear its definition. If the definition does not match the word you want, you can consider the other words with similar spellings or pronunciations that are frequently confused with it.

When you are finished with the dictionary and want to return to the document, click OK. All word changes are in the document.

For more information on using the dictionary, see Chapter 4, Write:OutLoud’s Talking Spell Checker and Talking Dictionary.

Tip for writers using alternate access: There are keyboard shortcuts for using the Spelling and Dictionary dialogs. See Appendix A for a complete list.
Add Picture

Students can enhance the meaning of their writing by adding illustrations or photographs to their documents. Write:OutLoud includes a library of sample pictures, and also supports other pictures that are Bitmaps (BMP), PICT or JPEG files. To place a picture in your Write:OutLoud document, click Add Picture.

Write:OutLoud sample pictures are organized by categories and kept in folders. Open the folder/category you want.

The list of pictures appears. A preview of the highlighted picture is shown next to the list.

Use the scroll bars to view other pictures in the folder. If you want to look in a different folder, double-click the arrow at the top of the list to go back one level in the Write:OutLoud Pictures folder.
When you find the picture you want, click OK.

![Add Picture dialog box]

The picture is inserted into your document.

![Mouse and Cheese story window]

Write:OutLoud automatically puts the picture in a new paragraph, with one blank line before and after the picture.

After a picture is inserted, the cursor advances to the next line for more typing.

Once the picture is added to your document, you can move it around or change its alignment. You can change its size and line spacing, too, if desired.

See Chapter 5, *Adding Pictures to Documents*, for more information on how to use pictures with Write:OutLoud.
**Appearance Buttons**

Write:OutLoud’s Appearance buttons let students change the way their document looks because they can see the tools and use them more easily than “hidden” menu items or commands. These tools give students control over font size and color, too.

![Appearance Buttons](image)

**Grow & Shrink**

Click Grow or Shrink to change the font or picture size. Highlight letters, words, sentences or pictures. Click Grow to increase the size. Click Shrink to decrease the size. Each time you click Grow or Shrink, the font will change to the next available font size. Pictures will automatically change size by 10%. Continue clicking until you get the size you want.

To change the size of the next text typed, click Grow or Shrink. Then type your next word. The size is changed.

Note: Because no text was selected, if you reposition the cursor before typing the next word, the change is cancelled.

To change the size of a section of your document, highlight the part(s) you want to effect, then click Grow or Shrink until the text is the size you want.

To resize the entire document, select all (Edit menu) and click Grow or Shrink until the text is the size you want.
Alignment

Choose how to align each paragraph: left, centered or right. Put the cursor in the paragraph you want to change. Each time you click Alignment, you cycle through the alignment options of Align Left, Align Center and Align Right. Continue clicking to cycle through the alignment options.

To change the current paragraph, click Alignment until you get the alignment you want.

To change the next paragraph, press Return to start a new paragraph, then click Alignment until the cursor indicates the alignment you want. Begin typing.

To change a section of your document, highlight the part(s) you want to effect, then click Alignment until you get the alignment you want.

To change the entire document to the same alignment, select all (Edit menu) and click Alignment until you get the alignment you want.

Background Color

Click Background Color to change the color of the entire document background. Each time you click this button, it cycles to the next available background color. Continue clicking to cycle through the color options.

Text Color

Change the color of the text. Select the word or words you want to change and click Text Color. Each time you click Text Color, it cycles to the next available text color. Continue clicking to cycle through the color options.

To change the color of the next text typed, click Text Color until the Text Color button displays the color you want the text to be. Then type to see the new text color.

Note: Because nothing was selected, if you reposition the cursor before typing the next word, the change is cancelled.

To change the text color of a section of your document, highlight the part(s) you want to effect, then click Text Color until the text is the color you want.

To change the text color of the entire document, select all (Edit menu) and click Text Color until the text is the color you want.

Tip: You can set the text, background and highlight colors for the document all at once by choosing Set Colors... in the Options menu. See Chapter 3, Using the Menus, for more information.
Chapter 3
Using the Menus

Besides using the toolbar to quickly access several functions, you can also use Write:OutLoud’s pull-down menus to access all functions and settings. This chapter describes all menu items and how to use them.

Note: See Appendix A for a complete listing of key equivalents for menu functions.

File Menu

The File menu includes standard items for file management. Some of these functions are also available in the toolbar.

New
Create a new document. The new document will use the current default settings.

Open…
Open an existing document. Write:OutLoud displays a standard file directory window.

Write:OutLoud can also open and read text files that are scanned in, created in other applications or downloaded from the Internet.
Chapter 3  Using the Menus

Close

Close the current document.

Save

Save changes to document and continue working. If the document is untitled, the standard Save window comes up so you can give it a name. Works exactly like the Save button in the toolbar.

Save As…

Save document with a new name and continue working. Or, you can save your document as a Text file to import it into another application. The original document remains intact.

Page Setup

Sets the page margins and measurement system for the current document.
Tip: Write:OutLoud automatically sets 1 inch margins for each side of the document. If you want your documents to have a different default setting, make changes here, then use Save As Default in the Options menu to keep those settings for all new documents.

Print Setup (Macintosh Only)

The Print Setup dialog lets you choose the printer, paper size, paper source and orientation. Appearance of the dialog will vary, depending on the operating system and print driver you use.

Print One

This skips the traditional dialog and directly prints one copy of the document. This is easy to use because it eliminates a step. Works exactly like the Print One button in the toolbar.

Print…

Choose print specifications from the print window and send document to the printer. You can print color documents in color if you have a color printer.

Recent Files List

This section of the File menu can show up to four of the most recently used files.

<table>
<thead>
<tr>
<th>List of up to four most recently-used files. Highlight the file you want to open</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Preview</td>
</tr>
<tr>
<td>Print One</td>
</tr>
<tr>
<td>Print...</td>
</tr>
<tr>
<td>1 UNTITLED1.WOL</td>
</tr>
<tr>
<td>2 Sue’s Speech.WOL</td>
</tr>
<tr>
<td>3 Letter.WOL</td>
</tr>
<tr>
<td>4 Color Words.WOL</td>
</tr>
<tr>
<td>Exit</td>
</tr>
</tbody>
</table>

Students can easily pull up their most recent files to resume working.

Exit or Quit

Quit the Write:OutLoud application. The program prompts you to save your work if you have not done so.
Edit Menu

<table>
<thead>
<tr>
<th>Edit Menu</th>
<th>Edit Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td><strong>Z</strong></td>
</tr>
<tr>
<td>Cut</td>
<td><strong>X</strong></td>
</tr>
<tr>
<td>Copy</td>
<td><strong>C</strong></td>
</tr>
<tr>
<td>Paste</td>
<td><strong>V</strong></td>
</tr>
<tr>
<td>Clear</td>
<td><strong>Delete</strong></td>
</tr>
<tr>
<td>Select All</td>
<td><strong>A</strong></td>
</tr>
<tr>
<td>End F</td>
<td><strong>End</strong></td>
</tr>
<tr>
<td>Quick Spelling...</td>
<td><strong>End</strong></td>
</tr>
<tr>
<td>Check Dictionary...</td>
<td><strong>End</strong></td>
</tr>
<tr>
<td>Cue Misspelling...</td>
<td><strong>Shift+H</strong></td>
</tr>
<tr>
<td>Add Picture...</td>
<td><strong>Shift+L</strong></td>
</tr>
<tr>
<td>Move to Beginning of Document</td>
<td><strong>Home</strong></td>
</tr>
<tr>
<td>Move to Next Sentence</td>
<td><strong>Shift+M</strong></td>
</tr>
<tr>
<td>Select Sentence</td>
<td><strong>Shift+M</strong></td>
</tr>
<tr>
<td>Move to End of Document</td>
<td><strong>End</strong></td>
</tr>
</tbody>
</table>

**Windows**

The Edit menu contains standard commands for document editing, including spell checker and dictionary. In addition, this menu has commands for document navigation and selection.

**Undo/Redo**

Undo cancels your last action. If your “undone” action can be repeated, Undo changes to Redo. This item is unavailable if your last action cannot be undone or redone.

**Cut**

Remove selection from document. Cut may be used with Paste.

Students can use Cut to move or remove sections of their document during the revision stages of the writing process.

**Copy**

Duplicate selection. Copy may be used with Paste.

Students can use Copy to “try out” a section of their document in a different part of the document while they’re revising text. If they like the change, they can Clear or Cut the duplicate passage.
**Paste**

Place cut or copied selection in your document at the cursor.

Students can use Paste to move sections or add duplicate sections of the document during the revision stages of the writing process.

**Clear**

Remove selection from document. Not used with Paste.

**Select All**

Highlight all text and pictures in the document.

With Select All, students can easily make global changes to paragraph alignment, font size or color.

**Find…**

Locate a specific word or group of words in text. Write:OutLoud displays the Find dialog. To move the dialog, drag the title bar.

> Displays the found phrase in context
> Type the word or phrase you want to find
> Click to find the next instance of the word or phrase

During the revision stages of writing, students can search their document for items they want to change or correct. This feature is very helpful when students are looking at a printed draft of their document.

**Tip for writers using alternate access:** There are keyboard shortcuts for using the Find dialog. See Appendix A for a complete list.
Check Spelling…

Select Check Spelling from anywhere in the document to begin the Franklin Spell Checker. Works exactly like the Check Spelling button in the toolbar.

Write:OutLoud always checks the entire document for spelling errors. Write:OutLoud displays the Spelling dialog when it finds a word that is not in either the regular Franklin or WOL User dictionaries.

The sentence containing the unknown or misspelled word (highlighted) is displayed, along with suggested known or correct words. Use the spell checker to hear the word in question spelled out and spoken in context and to hear other suggestions in its place. If the word in question is really a correct word or proper name, you can add it to the WOL User Dictionary by clicking Learn.

When you are finished with the spell checker and want to return to the document, click OK. All spelling changes are in the document.

For more information on using the spell checker, see Chapter 4, Write:OutLoud's Talking Spell Checker and Talking Dictionary.
Check Dictionary…

Check word meanings with the Franklin Dictionary and Homonym Checker. Works exactly like the Check Dictionary button in the toolbar.

Select the word you want to check and click Check Dictionary. If you don’t select a word, Write:OutLoud checks the word you just finished typing.

Write:OutLoud displays the Franklin Dictionary and Homonym Checker with the sentence that includes the word you are checking in the first window. The word meanings for the word in question are displayed in the second window and homonyms or confusables, if any, are displayed in the third window.

Use the dictionary to hear the word in question spelled out and spoken in context and to read and/or hear its definition. If the definition does not match the word you want, you can consider the other words with similar spellings or pronunciations that are frequently confused with it.

When you are finished with the dictionary and want to return to the document, click OK. All word changes are in the document.

For more information on using the dictionary, see Chapter 4, Write:OutLoud’s Talking Spell Checker and Talking Dictionary.
Cue Misspelling…

Change the settings for misspelling cues. Write:OutLoud monitors your words as you type. If you type a word it doesn’t recognize, it cues you with a sound (auditory) and/or menu bar flash (visual).

Choose any combination of cueing that you desire, or turn both off.

Change the Audio Cue

To see a list of available sounds, click the ellipsis symbol next to the Audio Cue field. Use the standard file directory window to select the sound file you want to cue misspelling. Or click Cancel to keep the current sound file for audio cueing.

Click OK when the settings are as you wish. Click Cancel to return to the document without making changes to settings.

Add Your Own Sound for the Audio Cue

If you have a different sound that you want to use for the Audio Cue, just copy the sound file into the Sounds folder in the Write:OutLoud folder. Then select Cue Misspelling and click the ellipsis symbol to select your sound file. Write:OutLoud will now use your sound for the audio cue.

Add Picture…

Initiate the Add Picture feature. Works exactly like the Add Picture button in the toolbar.

To place a picture in your Write:OutLoud document, select Add Picture.

Write:OutLoud includes a library of sample pictures, and also supports other pictures that are Bitmaps (BMP), PICT or JPEG files. Write:OutLoud pictures are organized by categories and kept in folders. Open the folder/category you want.
The list of pictures appears. A preview of the highlighted picture is shown next to the list. Use the scroll bars to view other pictures in the folder. If you want to look in a different folder, double-click the arrow at the top of the list to go back one level in the Write:OutLoud Pictures folder.

When you find the picture you want, click OK or press Return to accept it.

The picture is inserted into your document.

Once the picture is added to your document, you can move it around or change its alignment. You can change its size and line spacing, too, if desired.

See Chapter 5, *Adding Pictures to Documents*, for more information on how to use pictures with Write:OutLoud.
Move to Beginning of Document

Move the cursor to the top of the first page of the document. Works exactly like the Beginning button in the toolbar.

Students can quickly get back to the beginning of the document to add a title or start reviewing the Write:OutLoud document from the beginning of the story.

Move to Next Sentence

Move the cursor to the beginning of the next sentence. Works exactly like the Next button in the toolbar. Write:OutLoud knows a new sentence usually begins after a period, question mark or exclamation point.

Students can quickly navigate through their document for reading and revising the story.

Select Sentence

Highlight the next sentence. Works exactly like the Select button in the toolbar. If the cursor is at the end of a sentence, it highlights the whole next sentence. If the cursor is in a sentence, it highlights from the insertion point to the end of the sentence. Use this to speak or modify selected sentences.

Students can quickly select “chunks” of text for formatting or reading aloud, sentence-by-sentence.

Move to End of Document

Move the cursor to the bottom of the last page of the document. Works exactly like the End button in the toolbar.

Students can quickly get to the end of the document to add to existing work.
Text Menu

The Text menu lets you make changes to the font, size and style of text in your document. You decide what parts of the document the changes will effect.

How Text Options Work

To change the next text typed, make the desired changes to font, size and style. Then type to see the changes.

Note: Because no text was selected, if you reposition the cursor before typing the next word, the change is cancelled.

Tip: To hold the “changed” style without typing words, type Spacebar after making your style selections. Then you can reposition the cursor without the changes being cancelled. When you come back and type additional information on the line, the changes are still active. This is a useful technique when creating online quizzes or worksheets in Write:OutLoud.

To change a section of your document, highlight the part(s) you want to effect, then make the desired changes to font, size and style. The selected text will change to the settings selected.

To change the entire document, select all (Edit menu) and make the desired changes to font, size and style. The entire document will change to the settings selected.
Font

When opened, the Font dialog allows you to choose the font, the style and size of text for your document or text selection. See *How Text Options Work*, page 34.

Windows dialog

Macintosh dialog

Grow Selection

Choose Grow Selection to increase the size of all words you have selected. Works exactly like the Grow button in the toolbar. If nothing is selected, the next letters you type will be larger. See *How Text Options Work*, page 34.

Tip: You can also use Grow Selection to resize a picture you’ve added to your document. Just select the picture, then select Grow Selection (or click the Grow button in the toolbar). The picture will automatically increase in size by 10%. Continue until the picture is the size you want.
**Shrink Selection**

Choose Shrink Selection to decrease the font size of all the words you have selected. Works exactly like the Shrink button in the toolbar. If nothing is selected, the next letters you type will be smaller. See *How Text Options Work*, page 34.

**Note:** The minimum font size for Write:OutLoud is 4 point.

---

**Tip:** You can also use Shrink Selection to resize a picture you’ve added to your document. Just select the picture, then select Shrink Selection (or click the Shrink button in the toolbar). The picture will automatically decrease in size by 10%. Continue until the picture is the size you want.

---

**Regular**

When you choose Regular, all other styles are automatically turned off. See *How Text Options Work*, page 34.

**Bold**

Choose Bold to make the selected word(s) display in the bold version of the selected font. If no words are highlighted, the style applies to the next words typed. See *How Text Options Work*, page 34.

**Italic**

Choose Italic to make the selected word(s) display in the italic version of the selected font. If no words are highlighted, the style applies to the next words typed. See *How Text Options Work*, page 34.

**Underline**

Choose Underline to make the selected word(s) underlined. If no words are highlighted, the style applies to the next words typed. See *How Text Options Work*, page 34.
Options Menu

The Options menu includes features that effect how your document looks: colors, alignment, line spacing, how your toolbar looks and acts and whether or not you want to see page breaks. This menu also includes the Save As Default option that lets you change settings for all new documents created.

Hide/Show Toolbar

Hides or shows the toolbar at the top of the document.

Older students might want to hide the toolbar to make the document window look more age-appropriate or for class presentations.

Speak Toolbar

When checked, toolbar buttons say their names when they are clicked with the Right Mouse button (Windows) or when the cursor dwells over a button for a second or two (Macintosh). Select Speak Toolbar to uncheck and turn off toolbar speech.

Set Colors…

The Set Colors dialog lets you change the color of the text, background and highlight in one convenient place. Background and highlight color are global settings that effect your entire document. But you can change text colors for each word, sentence or section of your document if you like.

To change the text color of the next text typed, just select Set Colors… with no text highlighted.

To change the text color of a section of your document, highlight the part(s) you want to effect, then select Set Colors….
To change the text color of the entire document, select all (Edit menu), then Set Colors.

The Set Colors window is displayed. Select Text Color, Background Color or Highlight Color and choose the color you want for each.

As you make color selections, the Sample field previews the changes so you can see how the colors work together. Click OK after selecting the desired color(s).

**Note:** In most cases, Write:OutLoud will not allow you to select a color that is already in use by another color attribute. For instance, if your text color is pink, you cannot select pink as the highlight color or background color.

**Align Left**

Line up your text on the left with a ragged right side. This is how text usually appears. Change this setting by selecting another alignment option. See *How Alignment Works*, next page.

**Align Center**

Line up your text in the center of the page. This is useful for titles, etc. Change this setting by selecting another alignment option. See *How Alignment Works*, next page.
Align Right

Line up your text on the right with a ragged left side. Change this setting by selecting another alignment option. See How Alignment Works, below.

How Alignment Works

Each paragraph can have its own alignment.

To change the current paragraph, select the alignment option you want. The current paragraph will reflect the change.

To change the next paragraph, press {Return} to start a new paragraph, then select the alignment option you want. Begin typing to see the change.

To change a section of your document, highlight the part(s) you want to effect, then select the alignment option you want.

To change the entire document to the same alignment, select all (Edit menu), then select the alignment option you want.

This student chose Align Right for his name and grade.

The picture and title information is centered on the page with Align Center.

The body of the report is lined up on the left—the default setting of Align Left. (Tab was used to indent each paragraph.)

Treasure Island
by Robert Louis Stevenson

Treasure Island is an adventure about a young boy named Jim Hawkins. Jim's family ran an inn in England. A pirate captain named Flint stayed at the inn for a long time. Captain Flint died without paying his bill to Jim's mother. They really needed the money he owed them, so they looked in Flint's chest. His mother took some of the money they found, and Jim grabbed some papers. Then they hid.

Other pirates came and took the rest of the money. But the pirates were also looking for a treasure map. When they
Single Space

Lines of text are close together. Each line is situated one line of space. This is how text usually appears in newspapers and articles. Change this setting by selecting another line spacing option. See *How Line Spacing Works*, below.

Double Space

Lines of text are separated by space. Each line is situated on two lines of space. This is how formal papers are often formatted, and may help some students with visual processing of text. Change this setting by selecting another line spacing option. See *How Line Spacing Works*, below.

Triple Space

Lines of text are separated by more space. Each line is situated on three lines of space. This option is useful when printing drafts for peer proofreading because it leaves room for comments. Change this setting by selecting another line spacing option.

*How Line Spacing Works*

Each paragraph can have its own line spacing.

To change the current paragraph, select the line spacing option you want. The current paragraph will reflect the change.

To change the next paragraph, press Return to start a new paragraph, then select the spacing option you want. Begin typing to see the change.

To change a section of your document, highlight the part(s) you want to effect, then select the line spacing option you want.

To change the entire document to the same alignment, select all (Edit menu), then select the line spacing option you want.

*Hide/Show Page Breaks*

Select Show Page Breaks to show a dotted line around page margins and across the screen at page breaks. Use this setting to make sure your document will print the way you desire. Select Hide Page Breaks to view your document without these lines.

*Note:* Margin and page break “lines” will not print.

*Note:* When page breaks are displayed, the background color will stop at the margins of the page, leaving a white border around the active area of the document. When you select Hide Page Breaks, the background color will extend throughout the entire page.
Save As Default

Select Save As Default to save the current settings of font, color, spacing, alignment, margins, etc. to be the default settings for all new documents. For more information on saving file preferences and options for individual students and groups of students, see Saving Option Settings in Chapter 6, Using Write:OutLoud in the Classroom.

Speech Menu

<table>
<thead>
<tr>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Speech</strong></td>
<td><strong>Speech</strong></td>
</tr>
<tr>
<td>Turn Speech Off</td>
<td>CMD+O</td>
</tr>
<tr>
<td>Speak</td>
<td>CMD+T</td>
</tr>
<tr>
<td>Repeat</td>
<td>CMD+R</td>
</tr>
<tr>
<td>Speak Letters</td>
<td>CMD+L</td>
</tr>
<tr>
<td>✓ Speak Words</td>
<td>CMD+E</td>
</tr>
<tr>
<td>✓ Speak Sentences</td>
<td>CMD+M</td>
</tr>
<tr>
<td>✓ Speak Paragraphs</td>
<td>CMD+Y</td>
</tr>
<tr>
<td>✓ Highlight Word by Word</td>
<td>CMD+Shift+</td>
</tr>
<tr>
<td>Voice Settings...</td>
<td>CMD+</td>
</tr>
<tr>
<td>Pronunciations...</td>
<td>CMD+</td>
</tr>
</tbody>
</table>

**Turn Speech Off/On**

Toggles all speech options off and on. When turned off, the Speak and Repeat toolbar buttons are not available; Speak Toolbar in the Options menu is not available.

This is useful for users who want to turn off the speech options temporarily to work quietly, without altering their usual speech settings.

Tip: Earphones may be a good idea in a classroom, lab setting or workplace, eliminating outside sounds and distractions for the user as well as preventing the computer speech from becoming distracting to others in the environment. The same volume setting applies.

Choose Turn Speech On to have your speech settings active again.
Speak

Speak text. Works exactly like the Speak button in the toolbar.

Write:OutLoud speaks highlighted text or, if no text is highlighted, speaks the sentence containing the cursor. Click Speak again and the next sentence is spoken. With this feature, you can move through your entire document sentence-by-sentence, speaking each as you go.

To speak specific words or sentences, highlight the text first, then click Speak.

To speak the entire document, choose Select All in the Edit menu and click Speak.

Note: For speaking, sentences are spoken until sentence-ending punctuation or a paragraph break is encountered.

Students can control reading of their document for comprehension or revision.

Repeat

Repeat last spoken text. Works exactly like the Repeat button in the toolbar.

Students can repeat what was just heard to increase comprehension or when proofreading their work.
Stop Speech

Click this to immediately stop the current speech. This works exactly like the Stop button in the toolbar.

Students can immediately interrupt speech for any reason: to revise their work, work quietly, end a work session, make a different selection, etc.

Speak Letters

When checked, speaks each letter as it is typed. Choose Speaks Letters to uncheck.

Turn Speak Letters on for students learning keyboarding skills and students with physical disabilities or visual impairments to reinforce that the correct letter has been typed or selected.

Speak Words

When checked, speaks each word as it is completed. A word must be followed by a space, punctuation, or a paragraph return before Write:OutLoud can speak it. Choose Speak Words to uncheck.

Turn Speak Words on for students with learning disabilities and poor spellers for immediate auditory feedback that they have or have not typed the word they wanted.

Speak Sentences

When checked, speaks each sentence as it is completed. A sentence must be followed by punctuation (period, exclamation point or question mark) before Write:OutLoud will speak the sentence. Choose Speak Sentences to uncheck.

Turn Speak Sentences on for writers to hear completed sentences, or for students using Write:OutLoud for communication.

Speak Paragraphs

When checked, speaks each paragraph as it is completed. Write:OutLoud identifies a paragraph when a Return or Enter is selected. Choose Speak Paragraphs to uncheck.

Turn Speak Paragraphs on for reading lists, for writers to hear completed paragraphs, or for students using Write:OutLoud for communication.
Highlight Word by Word

When checked, individual words are highlighted as they are spoken. Choose Highlight Word by Word to uncheck.

Highlight Word by Word is an option that is helpful for students who are learning to read, or for students with visual tracking difficulties, because it helps students see and hear the word simultaneously.

Tip: This option slows down speech feedback somewhat. If speech seems sluggish on your computer, use a faster computer or uncheck this option while you work.

Voice Settings…

Opens the Voice Settings dialog. This is where the voice, speed and speech volume can be changed and tested.

Windows

Macintosh

Tip: Earphones may be a good idea in a classroom, lab setting or workplace, eliminating outside sounds and distractions for the user as well as preventing the computer speech from becoming distracting to others in the environment. The same volume setting applies.
Pronunciations…

Opens the Dictionaries dialog. The built-in speech does not always pronounce words exactly as you want; abbreviations and proper names are often mispronounced. Try out special words and names in Write:OutLoud first. If the pronunciation isn’t exact, choose Pronunciations… to add these words to the pronunciation exceptions dictionary.

Windows

Macintosh

The dictionary already contains pronunciations for many common abbreviations and proper names. Add your own to the list whenever you encounter a mispronounced word.
Windows Menu

Items that appear in this menu are names of Write:OutLoud documents that are currently open. The one that is checked is the current document. When you choose a different document, it moves to the front and you may work in it. You may have as many documents open as your computer memory will allow.

If there are more than nine documents open and the document you want is not listed in the menu, choose More Windows from the bottom of the Windows menu.

The Select Window dialog opens.

Highlight the document you want to work with, then click OK.
Help Menu

Windows

On-screen Help includes a review of Write:OutLoud features and functions. It also includes a list of key equivalents to perform functions without using the mouse.

The first Help window has a list of topics. Click on the topic you want to view and information will appear on that specific menu or topic.

Macintosh

<table>
<thead>
<tr>
<th>Help Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
</tr>
<tr>
<td>Using Help</td>
</tr>
<tr>
<td>About Write:OutLoud</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Balloon Help...</td>
</tr>
<tr>
<td>Show Balloons</td>
</tr>
<tr>
<td>Index</td>
</tr>
<tr>
<td>Using Help</td>
</tr>
</tbody>
</table>

Chapter 3  Using the Menus
Chapter 4
Write:OutLoud’s Talking Spell Checker and Talking Dictionary

“… I think we need to seek — continually — new ways to be successful with children and spelling. Getting an ‘A’ on a spelling test is simply not going to motivate some children. Then too, some children get ‘A’s’ but forget the words as soon as they pass the test. Building vocabulary, I have found, is not a kid’s goal; that’s a teacher goal. If you want kids to be motivated spellers you have to tie it to their life and the things they do.”

—Joe Turner
Center for Inquiry
Indianapolis, Indiana

Why Write:OutLoud’s Spell Checker and Dictionary Work

Recent educational research shows that the best way for students to learn spelling is to link it to writing. But students who are frustrated with their inability to recall the spelling of the word they want to use often give up and substitute a simpler word that is easier to spell. Students who know a word when they hear it may not recognize it in print. And many students also have difficulty distinguishing between homonyms and other “confusables.”

Write:OutLoud and the Franklin Spell Checker and Dictionary help students do just that. Hand-held Franklin Spell Checkers have been the teacher’s choice for students struggling with spelling because of their ease-of-use and capability to recognize homonyms and “phonetic” spellings of irregular words in addition to common misspellings. And Write:OutLoud has long been recognized as an effective tool for struggling writers because of its simplicity and powerful speech features.

With Write:OutLoud, the integrated Franklin Spell Checker and Dictionary become talking tools that go even further to help struggling students. The Franklin Spell Checker shows the word as used in context as well as possible alternate spellings. The student can see what they wrote and see if it is what they intended to write. Write:OutLoud can speak and spell out the word, the contextual sentence and suggested words to help students determine the correct spelling of the word they want.

The Franklin Dictionary also shows the word used in context and gives a brief definition of the word in question. It also lists homonyms and other similar words that could be confusing to the student. Again, Write:OutLoud can speak and spell out the word in question, the contextual sentence, definitions and suggested words to help students choose the word that really conveys the meaning they intend.
Using the Franklin Spell Checker in Write:OutLoud

You can initiate the spell check function in either of two ways:

- Click the Check Spelling button in the toolbar
- Select Check Spelling from the Edit menu

Write:OutLoud always checks the entire document for spelling errors.

The Spelling Dialog

Write:OutLoud displays the Spelling dialog when it finds a word that is not in either the regular Franklin or user dictionaries. The general buttons in the Spelling Window let you make changes to the document or Write:OutLoud User dictionary.

Learn

A separate WOL User Dictionary exists for personal words and names, and other words that are not contained in the standard Franklin Dictionary. Both the Franklin Dictionary and the WOL User Dictionary are referenced while checking spelling. To add the highlighted word to the WOL User Dictionary, click Learn.

Stop

At any time, click the Stop button to stop the speaking.

Next Word

If you don’t want to change the word in question, click Next Word to continue the spell check.
**Change**

When the correct word is in the Change to field, click Change. The word is replaced in your document, and the spell checker goes on to the next word in question, if any.

**OK**

When you are finished with the spell checker and want to return to the document, click OK. All spelling changes are in the document.

**Read Word Spelling**

When checked, Write:OutLoud spells out words in question and suggested words, letter-by-letter, after it speaks them.

This option is helpful because many questioned words might be spelled phonetically (and incorrectly) by the writer. When the word is spoken it will sound correct. However, when the word is spelled out, it may help the writer hear the difference between the word they typed and the correct spelling.

**The Word in Question Window**

The Spelling dialog displays the sentence containing the unknown or misspelled word (highlighted) along with suggested known or correct words. Use the spell checker to hear the word in question spelled out and spoken in context and to hear other suggestions in its place. If the word in question is really a correct word or proper name, you can add it to the WOL User Dictionary by clicking Learn.

**Speak Sentence and Word in Question**

To hear the sentence with the misspelled word, click the first Speak button. Write:OutLoud speaks the entire sentence and repeats the misspelled (highlighted) word. If Read Word Spelling is checked, Write:OutLoud also spells out the word in question, letter-by-letter.

**The Suggested Words Window**

**Speak the First Suggested Word**

Write:OutLoud suggests a word in the Change to field. To hear this word spoken and spelled, click the word to highlight it. The word moves to the Change to field. Click the Speak button next to the Suggested Words. If Read Word Spelling is checked, Write:OutLoud also spells out the suggested word, letter-by-letter.

**Speak More Suggested Words**

To hear another suggested word, click the word to select it and then click the Speak button. Ways to select a suggested word are:
Click the word.
- Use ↑ until the suggested word is selected.
- Type the key equivalent (Ctrl 1, Ctrl 2, etc.) that precedes the word you want to select.
- If there are more than five additional suggestions, use the scroll bar to view more, then click the word you want to select.

If the correct word doesn’t appear in the suggested word list, type the correct word in the Change to field.

### Using the Franklin Dictionary in Write:OutLoud

You can initiate the dictionary function in either of two ways:

- Click the Check Dictionary button in the toolbar

![Dictionary button](image)

- Select Check Dictionary from the Edit menu

The Dictionary dialog opens. In it, you can check word meanings with the Franklin Dictionary and Homonym Checker. Select the word or section of the document that you want to check. Then select Check Dictionary.

Note: If you don’t select a word or section of your document, Write:OutLoud checks only the word you just finished typing.
The Dictionary Dialog

Write:OutLoud displays the Franklin Dictionary and Homonym Checker with the sentence that includes the word you are checking in the first window. The word meanings for the word in question are displayed in the second window and homonyms, if any, are displayed in the third window.

Next Word
If more than one word was selected for Check Dictionary, click Next Word to continue the spell check without changing the current word in question.

Stop
At any time, click the Stop button to stop the speaking.

Change
When the correct word is in the Change to field, click Change. The word is replaced in your document, and the dictionary goes on to the next word in question, if any.

OK
When you are finished with the dictionary and want to return to the document, click OK. All changes are in the document.

Read Word Spelling
When checked, Write:OutLoud spells out words in question and homonyms, letter-by-letter, after it speaks them.

The Word in Question Window
Use the dictionary to hear the word in question spelled out and spoken in context.

Speak Sentence and Word in Question
The word in question and the sentence in which it appears is in the first window. To help understanding and independence, students may click the Speak button to hear the sentence. Write:OutLoud speaks the entire sentence and repeats the (highlighted) word in question. If Read Word Spelling is checked, Write:OutLoud also spells out the word in question, letter-by-letter.

The Definition Window
You can check the meaning of the word in question by looking at the second window. Definitions for the word in question appear there. If there are more meanings, they are listed also (you may have to scroll to bring them into view). If the definition does not match the word you want, you can consider the other words listed in the Homonyms window.
**Speak Definitions**

To help with understanding and independence, students may click the Speak button to listen to the definitions. This feature helps students check their own work for correct work usage.

**The Homonyms Window**

If the word in question has homonyms, confusing words with similar spellings or pronunciations, they are listed in the third window. This feature helps students understand that there are words that sound alike.

To help understanding and independence, students may click the Speak button to listen to the homonyms. To hear another suggested word, click the word to select it and click speak. Ways to select a suggested word are:

- Click the word.
- Use until the suggested word is selected.
- Type the key equivalent (Ctrl-1, Ctrl-2, Ctrl-3) that precedes the word you want to select.

If there are more than three additional suggestions, use the scroll bar to view more, then click the word you want to select.

The selected (highlighted) homonym appears in the Change To field. Its definition appears in the Definition field. If you want to replace the word in question with the selected homonym, click Change.

When you are finished checking definitions and making changes, click OK to return to your document.
Chapter 5
Adding Pictures to Documents

Pictures play an important role in telling stories and conveying information. When writers are revising their text for meaning, they might find something that is difficult to put adequately into words. Adding pictures is a natural way for writers to help make their ideas clearer.

Write:OutLoud includes a number of sample pictures which are organized into categories. It also can import pictures from clip art collections and other locations on your computer. After you select and add a picture to your document, you can resize it, change its alignment, copy or paste it in much the same way as you do text.

Add a Sample Picture

To place a picture in your Write:OutLoud document, position the cursor where you want your picture to be.

Click Add Picture, or select Add Picture from the Edit menu.

Write:OutLoud pictures are organized by categories and kept in folders. Double-click a folder or press Return to see the list of pictures in the category.

Write:OutLoud pictures are organized by categories and kept in folders. Double-click or press Return to open the highlighted folder/category.
The list of pictures appears. A preview of the highlighted picture is shown next to the list. Use the scroll bars to view other pictures in the folder. If you want to look in a different folder, double-click the arrow at the top of the list to go back one level in the Write:OutLoud Pictures folder.

When you find the picture you want, click OK.

The picture is inserted into your document.

Write:OutLoud automatically puts the picture in a new paragraph, with one blank line before and after the picture. After a picture is inserted, the cursor advances to the next line for more typing. Write:OutLoud automatically puts one blank line both before and after the picture to set it off from the text around it. This also makes it easy for the student to select the picture for additional formatting. Of course, you can delete the extra lines and even put more than one picture on a line if you want (provided the pictures are small enough to fit).
Add Your Own Picture

Write:OutLoud can also import graphics from other places on your computer. Select Add Picture.

To find other pictures, click Other in the Add Picture dialog.

Use the standard dialog directory to select a graphic from anywhere on your computer. Use the popup menu to change the file type, if necessary.

Select a picture file and click Open. The selected picture will be shown in the Preview window. If it is not the picture you wanted, click Other… to select a different picture.

Click OK to add the picture to your document.

Tip: For ease of use, add your own pictures to Write:OutLoud’s picture directory. See Adding Your Own Pictures to the Pictures Directory, p. 59.
Resizing Pictures

You can also make pictures bigger or smaller. Highlight the picture. Then click the Grow or Shrink Selection buttons, or choose the option you want from the Text menu. Each time you click the Grow or Shrink Selection button, the picture will change size.

You can also resize with the mouse cursor. To do that, click the pictures so that you see the selection box. Place your mouse pointer over the box in the lower right corner until your pointer changes to a double-arrowed cursor. Macintosh users, hold the mouse button down. Windows users, click the right mouse button.

Drag the corner of the picture box to make the box small or larger. Release the mouse button.
Changing Picture Alignment

When the picture is in your document, you can click the Alignment button to change how the picture lines up with your text.

Or, choose the specific alignment command you want from the Options menu.

The picture above is centered in the document.

Tip: Pictures are always inserted on their own line, with blank lines before and after the picture. After adding pictures, you can delete the extra blank lines and even add text to the lines containing the pictures if you want. You might want to put a \tab or \spacebar between the picture and the text.
Adding Your Own Pictures to the Pictures Directory

You can, of course, import pictures from anywhere on your hard drive, network or media in your computer. Locating files with the directory dialog may not be easy for some students.

To make pictures easy for students to find, you may want to add them right into the Write:OutLoud Pictures directory. To do this:

1. Locate the pictures you want to use.

2. Make sure the graphics are in a format that Write:OutLoud can import (BMP, PICT or JPEG—see Graphic Formats Supported, page 60, for more information).

3. Organize them into folders by subject or category. Name the folder(s) something unique so it is easy to remember what pictures are in them.

4. Copy or move the folder(s) into the Pictures folder within the WriteOutLoud folder.
Your picture folder(s) should be available in the Write:OutLoud Pictures directory when you select Add Picture.

**Graphic Formats Supported**

Write:OutLoud supports pictures that are Bitmaps, PICTs or JPEGs.

**Bitmaps (BMP)**

BMP is the standard Windows bitmap image format on DOS and Windows-compatible computers.

**PICT**

The PICT format is widely used among Macintosh graphics and page-layout applications.

**JPEG**

The Joint Photographic Experts Group (JPEG) format is often used to display photographs and other images in HTML documents over the World Wide Web and other online services. JPEG images can be compressed at different levels, so image quality can vary greatly. Most images downloaded from the Internet will be in JPEG format.

Tip: The Space folder in the Pictures folder contains sample JPEG photos for you to try with Write:OutLoud.
Chapter 6
Reading and Writing with Write:OutLoud

Write:OutLoud’s flexible speech options make it a powerful tool for reading, too. Many teachers use it to help “read aloud” materials that students otherwise might not be able to access or read themselves.

Materials may come from the Internet, other word processing applications or print materials that have been scanned in using a scanner and OCR software.

Write:OutLoud can open and work with any file that is saved in a Text-only file format.

Working with Scanned Text

Scanned-in worksheets, newspaper and magazine articles and other print materials can be opened by Write:OutLoud as long as they are saved in a Text (or Text-only) file format. After opening them, you can read and format them just as you can any other document in Write:OutLoud. Save them as a Write:OutLoud document for future use.

Tips for Scanning

There are some general guidelines you can follow to have success with your scanned text and Write:OutLoud.

► Scanning works best if you are working with a clean, legible copy of the print material. Use the best “original” possible to get the most accurate scan.

► Save the scanned material as TEXT or TEXT-only files. (Avoid using TEXT with line breaks; they are difficult to format.)

► Open the file in Write:OutLoud (choose Text files or All Files from the popup menu to see them).

► Change the font and font size to the size you want your students to use. You can also add pictures and color to the document, if desired.

► Proofread the document and run the spell checker before using the file with students.

Note: Spell checkers do not always find errors such as inserted ASCII characters.

► Save documents as Write:OutLoud files for future use.

Note: Different scanners and OCR programs have a wide range of capabilities and features. Consult the documentation for your equipment and software for best scanning results.
Application Ideas for Writing

Only your imagination limits what you can do with Write:OutLoud. Once you work with Write:OutLoud and experience how truly simple it is to use, you’ll enjoy thinking of ways to apply several features alone or in combination with your word processing needs. The following lists just a few ways that speech, color and text can enhance the writing process.

Write:OutLoud is a perfect way to encourage students to write. Try some of these activities with your students. Find those that are appropriate and motivating for your students, then encourage them to experiment with colors, font size and speech options.

Write & Listen — Letters and Words

These activities use letters, words and speech.

Names
Have students type their names and listen to it as many times as they like.

Find the Letters/Scribbling
Listen to letters. In the Speech menu, select Speak Letters. Type a letter and listen. Encourage students to find all the letters on the keyboard.

Kid Writing
Encourage beginning students to write by “sounding out” their words for daily journals or other first writing activities. In the Speech menu, turn on Speak Words and Speak Sentences. Turn off Speak Letters. It’s very important that there are no penalties for misspelling when doing kid writing. Select Cue Misspelling from the Edit menu and uncheck both Auditory and Visual Cueing.

Invent Words
Let students create their own nonsense or fantasy words. When they create a word they like, have them create additional words that rhyme with it.

New Words
Listen to words. In the Speech menu, select Speak Words. Ask students to type a new word for the day. When (Spacebar) is pressed, the word is spoken. When finished, click Speak to hear all the words.

Favorite Things
Ask students to list their favorite foods, toys or spelling words. Each word is spoken as it is typed. When the list is finished, click Speak in the toolbar to hear the entire list.
**Spelling Bee**

Have a spelling bee. Turn on the Auditory option for Cue Misspelling in the Edit menu. In turn, ask students to type a word. When a student’s computer “beeps,” a word is misspelled and they are out of the round. Turn speech off unless students are using headphones.

**Write & Listen — Stories**

These activities use sentences and speech.

**Journal**

Ask students to keep a journal for a specified time or during a special occasion such as a holiday vacation. When the journal is complete, take advantage of Write:OutLoud’s speech feedback to narrate it. This could be a fun classroom project.

**Summer Vacation**

A simple “what I did on summer vacation” assignment can become a talking adventure for the classroom setting.

**Storyteller**

Teachers can enter their own stories and have Write:OutLoud handle the storytelling.

**Student Stories**

Ask students to write a story about a spooky house, their favorite stuffed animal or their best friend. Whether or not students share their stories, they’ll develop pride when they hear Write:OutLoud speak their own stories.

**Write with Color**

If you are using a color monitor, take advantage of the options that let you set background and text color. Specify the color of paragraphs, sentences or individual words. Print in color, too, if you have a color printer. Here are some ideas.

**Noun Game**

Help students learn parts of speech by setting all nouns in a different color than the rest of the text. Or better yet, ask the students themselves to make all the nouns yellow. Then try this with verbs, adjectives and adverbs.

**Learn Colors**

Learn the colors. Type out the names of colors. Use the color options to reflect the word’s color. Then ask students to say what color a word is. To check if they are correct, have Write:OutLoud say the word. Highlight the word and click speak to learn the word.
Mad for Color

Use color to show and learn about emotions. Type the word “mad” in a large font using the color red. Try blue for “sad,” green for “envy” and others. Lead a simple activity similar to “learn colors” (above) or ask older students to write a story using different emotions with colors.

Holiday Colors

Use colors for themes centering on holidays. Select orange and black (Halloween), red and green (December), red and white (Valentine’s Day) and others.

Invisible Words

Type your text in the color that you want to be the final background color. With no text selected, change the text color. Then type something you can delete later (at least a word or two). Select the new text, then choose Set Colors… from the Options menu and make the background color the same color as the original text. Make sure the highlight color is a contrasting color. Go back to the document and click Speak. The text will become “visible” only when it is highlighted or spoken. Delete the unwanted words. You may have to experiment with this a bit before you get it to work the way you want.

Colorful Plays

Students can write plays with each character’s lines in a different color. Or, import text from existing plays and assign different colors to each characters’ lines. Print the plays out (using a color printer) for students to read aloud.

Write in Different Sizes and Styles

It may be easier on eyes if you use a big typeface in your documents. Users with visual impairments may benefit especially when using high contrast colors in the background and text.

First Words

When using Write:OutLoud as a first word processor, keep the font size big and the style simple to facilitate young readers.

Special Effects

Let older students have fun experimenting with the text styles. Create special effects with shadowing and outlining for unique printed pieces.
Writing Tips for Individuals with Unique Needs

Changing font sizes, colors and speech options can be beneficial to individuals with varying needs and abilities. Consider large fonts for those with visual impairments, auditory review of work for some users with learning differences and the speech feedback for nonspeaking students.

Color Contrast for Visual Needs

Write:OutLoud’s text and background color combinations may help users with visual impairments—a yellow background with black text offers a high contrast combination. Experiment to find the most beneficial color and font combination for the user. Also, adjust the color that is used to highlight words and sentences.

Speech Output for Communication

Try Write:OutLoud as a communication tool. Type a short paragraph about the day, a favorite joke or childhood memory. Save the file. The user may retrieve the file later and “tell” the story to friends, parents or teachers. Use navigation and speech buttons in the toolbar to retell stories, give speeches, etc.

Speech Feedback

Some users may benefit from listening to their work as they write. Use the combination of speech feedback that best meets your needs.

► Use Speak Letters for people with physical disabilities or visual impairments to reinforce that the correct letter has been typed.
► Use Speak Words for people with learning disabilities and poor spellers.
► Use Speak Sentences and/or Speak Paragraphs for beginning writers and for communication.

Keyboard Shortcuts

Using the keyboard or an alternate input device may be easier than using the mouse for some people. Nearly all functions in Write:OutLoud have key equivalents of one to three keys. Alternate input device users may want to define a key, square or code to execute the shortcuts with a single “keystroke.”

See Appendix A for a complete list of key equivalents for Write:OutLoud.
Saving Option Settings for Individual Writers

As you work with Write:OutLoud, you will find options and settings that you or your students find most useful. When you save a document, the settings are saved with the file. When you open that file, the settings remain as you changed them.

Default Settings

When you install Write:OutLoud, options are set as follows:

- **Cue Misspelling**: on
- **Left Alignment**: on
- **Show Toolbar**: on
- **Speak Toolbar**: on
- **Text Color**: blue
- **Background Color**: white
- **Highlight Color**: aqua
- **Show Page Breaks**: off
- **Speak Letters**: off
- **Single Spacing**: on
- **Speak Words**: on
- **Speak Sentences**: on
- **Speak Paragraphs**: off
- **Highlight Word by Word**: on
- **Font**: Arial (Windows)
  - Geneva (Macintosh)
  
- **Size**: 14 pt
- **Style**: plain
- **Page Margins**: 1 inch (on each side)

Changing Default Settings for All New Files

Your preferences for option settings may be very different than this and you may want Write:OutLoud to start new files with your setting preferences. Set the settings as you like. Then choose Save as Default in the Options menu to make those settings active for all new documents.

Saving File Preferences for Individual Users

If a number of students use the same computer but need different option settings, you can create “starting files” for each individual that will retain separate file preferences.

To create individual student files with different settings, use these steps:
Windows and Macintosh

1 Start a new file.
2 Do not type any text, but choose your options. Among them are:

- Font type, style and size
- Speech options
- Misspelling cue
- Text and background color
- Toolbar display on or off
- Text alignment (left, center or right alignment)

Tip: It may be easier to set options with text in the document. Type text to check settings, then delete it before saving the file.

3 Save the file with appropriate name such as “Sue's Starting File.”
4 Quit Write:OutLoud.

Windows (continued)

5 Locate your document in the file directory, then choose Properties… from the File menu.
6 Click Read Only. This creates a type of file that can be used as a template.
7 Double click Sue's Starting File to launch Write:OutLoud.
8 Save the file as you would a new file — choose Save as in the File menu. The original document remains unchanged for use over and over again. Even if you typed in the document or made other changes to it, its “Read Only” status would not let you overwrite the original file.

Macintosh (continued)

5 Locate your document in the file directory, then choose Get Info… from the File menu.
6 Click Stationery to check it. This creates a type of file that can be used as a template.
7 Double click Sue's Starting File to launch Write:OutLoud.
8 Save the file as you would a new file — choose Save in the File menu. The original document remains unchanged for use over and over again. Even if you typed in the document or made other changes to it, its “Stationery” status would not let you overwrite the original file.

Tip: Teachers may want to create starting files for each of their students. Also consider having the student create a folder for their starting and work files.
Appendix A

Key Equivalents for Write:OutLoud

Many Write:OutLoud functions can be carried out with keystrokes instead of the mouse.

The Toolbar

<table>
<thead>
<tr>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ ↑</td>
<td>Ctrl Home</td>
</tr>
<tr>
<td>⌘ Shift M</td>
<td>Ctrl Shift M</td>
</tr>
<tr>
<td>⌘ Shift M</td>
<td>Ctrl Shift X</td>
</tr>
<tr>
<td>⏏</td>
<td>Ctrl End</td>
</tr>
<tr>
<td>⏏</td>
<td>Ctrl T</td>
</tr>
<tr>
<td>⏏</td>
<td>Ctrl R</td>
</tr>
<tr>
<td>⌘ .</td>
<td>Ctrl .</td>
</tr>
<tr>
<td>⌘ S</td>
<td>Ctrl S</td>
</tr>
<tr>
<td>⌘ Shift P</td>
<td>Ctrl Shift P</td>
</tr>
<tr>
<td>⌘ P</td>
<td>Ctrl P</td>
</tr>
<tr>
<td>⌘ Q</td>
<td>Alt F 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>move cursor to beginning of file</td>
</tr>
<tr>
<td>move cursor one sentence forward</td>
</tr>
<tr>
<td>select next sentence</td>
</tr>
<tr>
<td>move cursor to the end of the file</td>
</tr>
<tr>
<td>speak highlighted text</td>
</tr>
<tr>
<td>repeat last spoken text</td>
</tr>
<tr>
<td>stop speaking</td>
</tr>
<tr>
<td>save document</td>
</tr>
<tr>
<td>print one</td>
</tr>
<tr>
<td>check spelling</td>
</tr>
<tr>
<td>check dictionary</td>
</tr>
<tr>
<td>add picture</td>
</tr>
<tr>
<td>grow (make larger)</td>
</tr>
<tr>
<td>shrink (make smaller)</td>
</tr>
<tr>
<td>cycle through alignment options</td>
</tr>
<tr>
<td>cycle through background colors</td>
</tr>
<tr>
<td>cycle through text colors</td>
</tr>
</tbody>
</table>

File Management

<table>
<thead>
<tr>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>⌘ N</td>
<td>Ctrl N</td>
</tr>
<tr>
<td>⌘ O</td>
<td>Ctrl O</td>
</tr>
<tr>
<td>⌘ W</td>
<td>Ctrl F 4</td>
</tr>
<tr>
<td>⌘ S</td>
<td>Ctrl S</td>
</tr>
<tr>
<td>⌘ H</td>
<td>Ctrl H</td>
</tr>
<tr>
<td>⌘ J</td>
<td>Ctrl J</td>
</tr>
<tr>
<td>⌘ Shift P</td>
<td>Ctrl Shift P</td>
</tr>
<tr>
<td>⌘ P</td>
<td>Ctrl P</td>
</tr>
<tr>
<td>⌘ Q</td>
<td>Alt F 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>new document</td>
</tr>
<tr>
<td>open document</td>
</tr>
<tr>
<td>close document</td>
</tr>
<tr>
<td>save document</td>
</tr>
<tr>
<td>save as…</td>
</tr>
<tr>
<td>page setup</td>
</tr>
<tr>
<td>print one</td>
</tr>
<tr>
<td>print</td>
</tr>
<tr>
<td>quit Write:OutLoud</td>
</tr>
</tbody>
</table>
### Moving The Text Insertion Cursor

Point and click with the mouse or use these keystrokes:

<table>
<thead>
<tr>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>→</td>
<td>→</td>
</tr>
<tr>
<td>←</td>
<td>←</td>
</tr>
<tr>
<td>↓</td>
<td>↓</td>
</tr>
<tr>
<td>↑</td>
<td>↑</td>
</tr>
<tr>
<td>Ctrl Shift K</td>
<td>Ctrl →</td>
</tr>
<tr>
<td>Ctrl Shift J</td>
<td>Ctrl ←</td>
</tr>
<tr>
<td>Ctrl Shift M</td>
<td>Ctrl Shift M</td>
</tr>
<tr>
<td>Ctrl Shift I</td>
<td>Ctrl Shift I</td>
</tr>
<tr>
<td>Ctrl Shift X</td>
<td>Ctrl X</td>
</tr>
<tr>
<td>Ctrl Shift E</td>
<td>Ctrl E</td>
</tr>
<tr>
<td>⌘ ↑</td>
<td>Ctrl Home</td>
</tr>
<tr>
<td>⌘ ↓</td>
<td>Ctrl End</td>
</tr>
</tbody>
</table>

- one character forward
- one character backward
- one line forward
- one line backward
- one word forward
- one word backward
- one sentence forward
- one sentence backward
- one paragraph forward
- one paragraph backward
- to the beginning of the file
- to the end of the file

### Selecting Text

When text is highlighted, you can change its font, style, size and color, or speak it. Traditionally, this is done by the mouse with click and drag. Key equivalents are as follows:

<table>
<thead>
<tr>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift →</td>
<td>Shift →</td>
</tr>
<tr>
<td>Shift ←</td>
<td>Shift ←</td>
</tr>
<tr>
<td>Shift ↓</td>
<td>Shift ↓</td>
</tr>
<tr>
<td>Shift ↑</td>
<td>Shift ↑</td>
</tr>
<tr>
<td>⌘ Shift K</td>
<td>Ctrl Shift →</td>
</tr>
<tr>
<td>⌘ Shift J</td>
<td>Ctrl Shift ←</td>
</tr>
<tr>
<td>⌘ Shift M</td>
<td>Ctrl Shift X</td>
</tr>
<tr>
<td>⌘ Shift I</td>
<td>Ctrl Shift E</td>
</tr>
<tr>
<td>⌘ Shift X</td>
<td>Ctrl E</td>
</tr>
<tr>
<td>⌘ Shift End</td>
<td>Ctrl Home</td>
</tr>
<tr>
<td>⌘ A</td>
<td>Ctrl A</td>
</tr>
</tbody>
</table>

- one character forward
- one character backward
- one line forward from cursor
- one line backward from cursor
- one word forward
- one word backward
- one sentence forward
- one sentence backward
- one paragraph forward
- one paragraph backward
- to beginning of file from cursor
- to end of file from cursor
- whole document
Editing Text

Macintosh

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z</td>
<td>undo typing</td>
</tr>
<tr>
<td>X</td>
<td>cut selection</td>
</tr>
<tr>
<td>C</td>
<td>copy selection</td>
</tr>
<tr>
<td>V</td>
<td>paste</td>
</tr>
<tr>
<td></td>
<td>clear selection</td>
</tr>
<tr>
<td></td>
<td>select all</td>
</tr>
<tr>
<td></td>
<td>find word</td>
</tr>
<tr>
<td></td>
<td>check spelling</td>
</tr>
<tr>
<td></td>
<td>check dictionary</td>
</tr>
<tr>
<td></td>
<td>cue misspelling</td>
</tr>
<tr>
<td></td>
<td>add picture</td>
</tr>
</tbody>
</table>

Windows

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl Z</td>
<td>undo typing</td>
</tr>
<tr>
<td>Ctrl X</td>
<td>cut selection</td>
</tr>
<tr>
<td>Ctrl C</td>
<td>copy selection</td>
</tr>
<tr>
<td>Ctrl V</td>
<td>paste</td>
</tr>
<tr>
<td>Backspace</td>
<td>clear selection</td>
</tr>
<tr>
<td>Ctrl A</td>
<td>select all</td>
</tr>
<tr>
<td>Ctrl F</td>
<td>find word</td>
</tr>
<tr>
<td>Ctrl G</td>
<td>check spelling</td>
</tr>
<tr>
<td>Ctrl 1</td>
<td>check dictionary</td>
</tr>
<tr>
<td>Ctrl Shift ]</td>
<td>cue misspelling</td>
</tr>
<tr>
<td>Ctrl Shift I</td>
<td>add picture</td>
</tr>
</tbody>
</table>

Formatting Document and Changing Text Styles

Changes will effect selected text (and pictures, if applicable), or additions to the document, starting from the point of the cursor.

Macintosh

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>font options dialog</td>
</tr>
<tr>
<td>1</td>
<td>grow selection (make larger)</td>
</tr>
<tr>
<td>]</td>
<td>shrink selection (make smaller)</td>
</tr>
<tr>
<td>L</td>
<td>plain letters</td>
</tr>
<tr>
<td>B</td>
<td>bold letters</td>
</tr>
<tr>
<td>I</td>
<td>italic letters</td>
</tr>
<tr>
<td>U</td>
<td>underline letters</td>
</tr>
<tr>
<td>'</td>
<td>set colors</td>
</tr>
<tr>
<td>Shift )</td>
<td>cycle through text colors</td>
</tr>
<tr>
<td>Shift \</td>
<td>cycle through background colors</td>
</tr>
<tr>
<td>.</td>
<td>align left</td>
</tr>
<tr>
<td>-</td>
<td>align center</td>
</tr>
<tr>
<td>/</td>
<td>align right</td>
</tr>
<tr>
<td>Ctrl Tab</td>
<td>cycle through alignment options</td>
</tr>
<tr>
<td>\</td>
<td>show/hide page breaks</td>
</tr>
</tbody>
</table>

Windows

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl 2</td>
<td>font options dialog</td>
</tr>
<tr>
<td>Ctrl ]</td>
<td>grow selection (make larger)</td>
</tr>
<tr>
<td>Ctrl [</td>
<td>shrink selection (make smaller)</td>
</tr>
<tr>
<td>Ctrl L</td>
<td>plain letters</td>
</tr>
<tr>
<td>Ctrl B</td>
<td>bold letters</td>
</tr>
<tr>
<td>Ctrl I</td>
<td>italic letters</td>
</tr>
<tr>
<td>Ctrl U</td>
<td>underline letters</td>
</tr>
<tr>
<td>Ctrl '</td>
<td>set colors</td>
</tr>
<tr>
<td>Ctrl Shift )</td>
<td>cycle through text colors</td>
</tr>
<tr>
<td>Ctrl Shift \</td>
<td>cycle through background colors</td>
</tr>
<tr>
<td>Ctrl .</td>
<td>align left</td>
</tr>
<tr>
<td>Ctrl -</td>
<td>align center</td>
</tr>
<tr>
<td>Ctrl /</td>
<td>align right</td>
</tr>
<tr>
<td>Ctrl Tab</td>
<td>cycle through alignment options</td>
</tr>
<tr>
<td>Ctrl \</td>
<td>show/hide page breaks</td>
</tr>
<tr>
<td>Ctrl Shift \</td>
<td>save current settings as default</td>
</tr>
</tbody>
</table>
## Speaking Text

Speak words while typing text or later by highlighting the text.

### Macintosh

<table>
<thead>
<tr>
<th>Key</th>
<th>Windows</th>
</tr>
</thead>
</table>
| ⌘ T   | Ctrl T  | speak highlighted text
| ⌘ R   | Ctrl R  | repeat last spoken text
| ⌘ .   | Ctrl .  | stop speaking

Toggle these options on or off with the mouse (Speech menu) or use these key equivalents.

<table>
<thead>
<tr>
<th>Key</th>
<th>Windows</th>
</tr>
</thead>
</table>
| ⌘ K   | Ctrl K  | speak letters when typed
| ⌘ E   | Ctrl E  | speak words when typed
| ⌘ M   | Ctrl M  | speak sentences when typed
| ⌘ Y   | Ctrl Y  | speak paragraphs when typed
| ⌘ D   | Ctrl D  | turn speech on and off
| ⌘ <   | Ctrl <  | highlight word by word

### Voice

<table>
<thead>
<tr>
<th>Key</th>
<th>Windows</th>
</tr>
</thead>
</table>
| ⌘ \   | Ctrl \  | voice settings
| ⌘ =   | Ctrl =  | pronunciations

## Pronunciation… Dictionary Dialog

<table>
<thead>
<tr>
<th>Key</th>
<th>Windows</th>
</tr>
</thead>
</table>
| Tab    | Tab     | move between fields
| Return | Enter   | add to exceptions dictionary
| Delete |         | delete word
| Esc    | Esc     | close window and ignore changes
## Find Dialog

<table>
<thead>
<tr>
<th>Macintosh</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + T</td>
<td>Ctrl + T</td>
</tr>
<tr>
<td>Return</td>
<td>Return</td>
</tr>
<tr>
<td>Esc</td>
<td>Esc</td>
</tr>
</tbody>
</table>

- speak highlighted field
- find next word
- cancel

## Spelling Dialog

- speak highlighted field
- move through suggested words
- close window
- move between fields

## Dictionary Dialog

- speak highlighted field
- move through suggested words
- close window
- move between fields
Appendix B

The Abbreviations File

The WOL Abbreviations file was copied to your hard drive when you installed Write:OutLoud. This file contains common abbreviations such as Mr., Mrs. and Dr. Write:OutLoud uses the abbreviations file so that it knows that a period in this context is not the end of a sentence.

The full list of abbreviations supported by Write:OutLoud appears below. If you use an abbreviation that is not on the list, Write:OutLoud will assume it is the end of a sentence.

1. C.  I.  Mtn.  Sat.
2. Can.  i.e.  N.  S.E.
3. C.E.O.  ie.  N.A.  Sec.
4. cm.  in.  N.E.  Sep.
A. D.C.  kg.  Ph.D.  S.W.
A.C. Dec.  km.  Pkg.  T.
A.D. Dept.  L.  Pkwy.  Ter.
a.m. Dir.  lb.  Pl.  Terr.
A.M. Dist.  Ln.  p.m.  Thu.
A.P. D.J.  lt.  P.M.  Thurs.
Apr. Dr.  Ltd.M.  P.O.  Treas.
Asmn. e.g.  Mar.  p.s.  U.
Attn. esp.  M.B.A.  P.S.T.  U.K.
Aug. E.S.T.  M.D.  P.T.  Univ.
Assoc. F.  MD.  P.T.A.  U.S.
Asst. Feb.  mm.  Pty.  U.S.A.
Ave. Fr.  Mon.  Q.  V.
B. Fri.  Mr.  R.  V.P.
B.A. ft.  Mrs.  Rd.  W.
B.C. G.  M.S.  Rev.  Wed.
Bldg. gm.  Ms.  Rt.  X.
Blvd. H.  Msgr.  Rte.  Y.
B.S. Hwy.  M.S.T.  S.  Z.

Appendix B  Abbreviations  73
Appendix C
Discover Setups for Write:OutLoud

A number of setups for alternate access with Discover products were included with Write:OutLoud. The Standard Install option installs them in a Discover Setups folder within your WriteOutLoud folder.

It's easy to use these custom setups with Write:OutLoud:

1 Move or copy the setups for your input method to the corresponding folder within the Discover folder on your hard drive. See Move or Copy the Setups, page 76.

2 Make sure your Discover software is active (see your Discover documentation for more information), then launch Write:OutLoud.

3 Attach the “Start Here” setup you want to use with Write:OutLoud. See Attach Setups to Write:OutLoud, page 76.

4 Begin using your alternate input method to run Write:OutLoud. See your Discover documentation for more information on your input method.

Tip: If you did not install the Discover setups, or need to reinstall them, use the Custom Install option of the Write:OutLoud v3 Installer to reinstall the setups onto your hard drive.

Move or Copy the Setups

You will need to move the setups you want to use to the main Discover folder on your hard drive. For instance, if you only use one input method, like Discover:Screen, you would only need to move the setups in the “WOL 3.0 Screen” folder.
**Setups Included**

Several setups for each of three common input methods were included. These setups were designed specifically to work with Write:OutLoud and include the commands needed to use the program.

Of course, you can attach and use any standard “full-access” setup with Write:OutLoud if you wish.

**Discover:Board Setups**

Discover:Board setups are within a folder named “WOL 3.0 Board.” You can print the overlays using Discover Create (Macintosh) or the edit mode of Discover (Windows). Use these setups with Discover:Board or with Discover:Kenx and alternate keyboard input.

**Discover:Screen Setups**

Discover:Screen setups are within a folder named “WOL 3.0 Screen.” Choose the “Start Here” setup with the onscreen layout that you prefer. Use these setups with Discover:Screen or with Discover:Kenx and onscreen input.

**Discover:Switch Setups**

Discover:Switch setups are within a folder named “WOL 3.0 Switch.” Use these setups with Discover:Switch or with Discover:Kenx and single-switch scanning input.
Attach Setups to Write:OutLoud

Attach a Setup on First Use

When you launch a new application program, Discover “sees” that there is no Discover attachment and the Setups dialog appears, prompting you to attach a setup.

Windows

Macintosh

Click “Choose a different setup to attach,” then click OK (Windows) or Done (Macintosh). The Setup Directory dialog appears.

Windows

Macintosh

Scroll through the directory until you find the “Start Here” setup you want to attach. Click to highlight the setup. Then Click Open (Windows) or Open Setup (Macintosh) to attach the setup.
Change Attached Setup

**Discover: Kenx**

If you want to use a different setup than the one you initially attached to Write:OutLoud, you can change the attachment. From the Discover menu, select Choose User.

**Windows**

Highlight a user’s name, then click Setup Links to change the attachment. A list of applications that have defined attachments appears.

**Macintosh**

Highlight “WriteOutLoud v3” and click Attach New to select a different setup attachment. The Setup Directory dialog appears.

**Windows**

Scroll through the directory until you find the “Start Here” setup you want to attach. Click to highlight the setup. Then Click Open (Windows) or Open Setup (Macintosh) to attach the setup. You are returned to the Setup Links directory.
Click OK (Windows) or Done (Macintosh) when you are done changing attachments for the selected user. Continue as needed for other users.

**Discover:Board, Discover:Screen or Discover:Switch**

If you want to use a different setup than the one you initially attached to Write:OutLoud, you can change the attachment. From the Discover menu, select Change Attachments. A list of applications that have defined attachments appears.

**Windows**

Highlight an application and click Attach New to select a different setup attachment. The Setup Directory dialog appears.

**Macintosh**

Scroll through the directory until you find the “Start Here” setup you want to attach. Click to highlight the setup. Then Click Open (Windows) or Open Setup (Macintosh) to attach the setup. You are returned to the Setup Links directory. Click OK (Windows) or Done (Macintosh) when you are done changing attachments.
Appendix D

Problem Solving and Frequently-Asked Questions

Refer to this section if Write:OutLoud is not working properly. Look for your situation and try the suggested solutions. If you continue to have difficulty, contact Don Johnston technical support for further assistance.

Speech Problems

My speech commands are not working when I type the key equivalents or use my alternate access device to send the commands.

► Perhaps all the speech was turned off somehow (Turn Speech Off in the Speech menu). This command temporarily disables all of Write:OutLoud’s speech feedback. No speech commands will work until you toggle speech back on. Select Turn Speech On from the Speech menu.

Write:OutLoud is “spelling out” every letter for the words typed, instead of speaking a whole word.

► Words typed in all capital letters or unusual words may not be recognized by the speech software. Try a different voice (Voice Settings in the Speech menu). Add words that remain a problem to your Pronunciation Exception Dictionary.

The speech doesn’t match the text that is highlighted — the highlighting is delayed, coming after the speech is heard.

► If you are working with a larger document and Highlight Word by Word is on, there may be a discrepancy between the spoken and highlighted text. This is most noticeable on older, slower machines and becomes more pronounced as the document size increases. Keep documents smaller or turn Highlight Word by Word off.

I get an “undetermined speech error” (Macintosh) or “speech files not found” (Windows) when I launch Write:OutLoud. I can still open existing documents or create new ones but no speech functions work.

There is a conflict or problem with the speech files in your system.

► Check the Extensions Manager Control Panel. Make sure your speech extensions are turned on. If any have been turned off, check them again and restart your computer.

► (Macintosh) Reinstall the text-to-speech files from your system disk or the Write:OutLoud CD. Use the Custom Install option.

► (Windows) Reinstall the ViaVoice files from the Write:OutLoud CD. Use the Custom Install option.
Working with Pictures

I just added a picture to my document, and there is too much “white” space around it. What can I do?

There are several things that can cause extra “white” space around a picture in Write:OutLoud, and different ways to eliminate it.

- Write:OutLoud automatically adds one blank line both before and after each picture when it inserts it into the document. If your cursor was already on a blank line when you selected Add Picture, there will be an additional blank line between the text and pictures. Delete any extra blank lines around your picture.

- Check the Line Spacing option (Options menu) selected for your picture to see if Double or Triple Space is selected. If so, this would account for a very large white space above the picture. Select Single Space to eliminate the space.

- There may be a lot of white space around the image in the picture file. Open the original picture file with a graphic application and crop the image closer. Save the picture to keep the changes, then re-import it into Write:OutLoud.

I centered my picture in my document but now the text after it is centered, too. Why did this happen?

- If you highlighted the picture to change alignment, you may have also selected blank lines before or after the picture and realigned them as well. First, click to position your cursor in the paragraph you want to change, then click Alignment until your text is aligned the way you want.

- Is the picture large—stretching from margin to margin? Even though they may appear to be on separate lines, Write:OutLoud may think the text is in the same paragraph as the picture, especially if you began typing immediately after changing alignment or another formatting option. Place your cursor immediately after the picture and add a paragraph return to format the picture and text separately.

Windows—Using Write:OutLoud with Co:Writer

I installed both Co:Writer and Write:OutLoud v3 on my Windows machine. Write:OutLoud works fine but I get a “can’t find speech” error when I launch Co:Writer.

- Co:Writer v3.2.2 uses different speech files than Write:OutLoud v3. If you installed Co:Writer after you installed Write:OutLoud v3, the Co:Writer Installer removed a system file needed for speech access. To fix the problem, reinstall Write:OutLoud v3 to restore all the speech files.

Note: If you are installing both programs, install Co:Writer first, then install Write:OutLoud.
Macintosh

When I start a new document, I can’t see my text—it looks like I’m typing white text on a white background.

You have selected a MacinTalk 2 voice in your Speech control panel and inadvertently corrupted the WOL Preferences file. MacinTalk 2, an older version of Macintosh text-to-speech, is incompatible with Write:OutLoud v3. This might happen if you have MacinTalk 2 in your system from another talking application. To solve the problem:

1. Quit Write:OutLoud.
2. Open the Speech control panel.
3. Select a MacinTalk 3 or MacinTalk Pro voice (we suggest Kathy or Fred). Close the control panel.
4. Find the WOL Preferences file (System folder > Preferences folder). Drag it to the Trash.
5. Open Write:OutLoud.

To avoid the recurrence of this problem, we recommend that you delete the MacinTalk 2 voices from your system. Most talking applications will work fine with newer voices from MacinTalk Pro and MacinTalk 3. You can test this with your other talking programs if you wish. To delete MacinTalk 2:

1. Locate the Voices folder in the Extensions folder within your System folder. Double-click to open the folder. Display by icon (View menu).
2. Find the voices that have a MacinTalk 2 icon (or a “generic” icon).
3. Drag the MacinTalk 2 voices to the Trash.

I opened several different documents at the same time and they had the wrong content in them! They were OK when I created them. What happened to my files?

If you try to open multiple documents from the desktop (by highlighting them and selecting Open from the Macintosh File menu), sometimes Write:OutLoud gets confused. There are several ways to successfully open multiple documents.

- Close the documents and open them one-at-a-time from the desktop.
- Close the documents and open them from within Write:OutLoud.
When I try to launch Write:OutLoud, I get an error message that Write:OutLoud “can’t find dictionary.”

You have selected a MacinTalk 2 voice in your Speech control panel and inadvertently corrupted the WOL Preferences file. MacinTalk 2, an older version of Macintosh text-to-speech, is incompatible with Write:OutLoud v3. This might happen if you have MacinTalk 2 in your system from another talking application. To solve the problem:

1. Quit Write:OutLoud.
2. Open the Speech control panel.
3. Select a MacinTalk 3 or MacinTalk Pro voice (we suggest Kathy or Fred). Close the control panel.
4. Find the WOL Preferences file (System folder > Preferences folder). Drag it to the Trash.
5. Open Write:OutLoud.

To avoid the recurrence of this problem, we recommend that you delete the MacinTalk 2 voices from your system. To delete MacinTalk 2:

1. Locate the Voices folder in the Extensions folder within your System folder. Double-click to open the folder. Display by icon (View menu).
2. Find the voices that have a MacinTalk 2 icon (or a “generic” icon).
3. Drag the MacinTalk 2 voices to the Trash.

I sometimes get a “low-memory” message when I’m using Write:OutLoud, especially if I’m adding pictures to my document. Why does this happen?

If you are adding BMPs, large pictures or multiple pictures to a document, you may get a low memory message from Write:OutLoud. This is especially common if you don’t have a lot of available RAM when you launch the program.

- You may have other open applications that are using available memory. Check the Application menu (upper right-hand corner) to see a list of active applications. Select and quit the ones you are not using.
- Check the amount of RAM available for your computer. From the desktop, choose About this Computer from the Apple menu. You will need a minimum of 5,000K available to launch Write:OutLoud; 8,000K is the preferred amount.
- If you are using a PowerPC, turn Virtual Memory on for better memory usage for Write:OutLoud.
- You can allocate more memory to the Write:OutLoud application to avoid this problem. To allocate more memory to Write:OutLoud:
1 Select the WriteOutLoud application icon from the WriteOutLoud folder on your desktop.

2 Select Get Info… from the File menu.

3 Find the memory part of the dialog (in System 8.x, you may have to click the Memory tab to show it) and increase the *preferred size* allocated to Write:OutLoud. If you frequently use more than one application at a time, you may want to increase the *minimum size* allocated to Write:OutLoud to 8,000K. This would ensure that you always had enough memory to use the full picture functions of Write:OutLoud.

4 Close the Get Info window. The new memory settings will take effect the next time you launch Write:OutLoud.

---

I used the Font dialog to change the font size of my document and now I can’t see anything on screen. What happened?

► The Font dialog will allow you to type in a font size as high as 9999 points, which is far too large to display on screen. From the Edit menu, choose Select All. Then choose Font… from the Text menu and type in a lower value for font size. Note: 72 points is equivalent to 1-inch high letters.

---

General

My toolbar has disappeared from the top of my document.

► Somehow Hide Toolbar was selected from the Options menu (or the key equivalent was used). Select Show Toolbar from the Options menu to toggle it back on.

The menu bar keeps flashing at me. How can I get it to stop?

► Write:OutLoud thinks you have misspelled a word. Use Check Spelling to use the Franklin Spell Checker and Dictionary. If the words that are “misspelled” are real words or personal names, you can add them to the WOL User Dictionary by clicking Learn in the Spelling window.

► Check the sound volume level on your computer. When your sound is turned all the way down, or muted, the menu bar may flash to indicate a “system beep.”
Cross-Platform File Compatibility

I need to use Write:OutLoud on a Macintosh computer at school and on my PC at home (or vice-versa). How do I share files between the two platforms?

► If you have Write:OutLoud v.3 installed on both computers, Write:OutLoud files are cross-platform. First of all, use a DOS-formatted disk (you can format the disk on either your PC or Macintosh computer). Then, name your file with the extension “.wol” so that the file can be identified as a Write:OutLoud file on the PC. “Terry’s Journal.wol” would be an example file name.

When I open my files on a different computer, sometimes the fonts are changed. What happened?

► Write:OutLoud will maintain as much file integrity as it can when it opens files created on a different system, but will substitute fonts if the original font is not available. This is common, especially when working with cross-platform files.

I created some Write:OutLoud files on a Macintosh and saved them to a PC disk, but I forgot to add the “.wol” extension to the file name. When I try to open them from Write:OutLoud on my PC, the files are not listed. Is there anything I can do?

► From within Write:OutLoud, select Open from the File menu. From the popup menu in the File Directory dialog, select All Files. The Macintosh file names should appear. You can open and resave them with the correct extension for future use.
I created some Write:OutLoud files on a PC and saved them to a disk. When I double-click the file to open them in Write:OutLoud on my Macintosh, a dialog asks me what program to link them to. What happened?

DOS and Windows files can be opened and used on a Macintosh in two ways:

► From within Write:OutLoud, select Open from the File menu. The file names should now appear.

► You can double-click the document icon to open the file if Write:OutLoud has been set up as the application assigned to files with the extension “.wol” following their name. To do this, open the File Exchange control panel.

Click the Add button in the PC Exchange tab. The Add Mapping dialog opens.

Find the Write:OutLoud v3 application in the Map to field and highlight it. Then, type “wol” in the Extension field. Click Add. Write:OutLoud files created on the PC will now automatically be linked to Write:OutLoud when you move them to this Macintosh.
Index

A

Abbreviations
  list of standard 73
  pronunciations of 45
Add Picture
  button 19, 54
  command 31, 54
  description of feature 31–54, 54
  key equivalent for 68, 70
Adding
  pictures to documents 19–21, 31–32, 54
  pronunciations to exceptions dictionary 45
  sounds for audio cueing 31
  to WOL pictures directory 59
  words to WOL User Dictionary 49
Align Center command 38, 70
Align Left command 38, 70
Align Right command 39, 70
Alignment
  button 23
  command 70
  description of feature 23, 38–39, 39
  key equivalent for 68
  of pictures 58
  problems 80
Alternate access
  using Discover Setsups for Write:OutLoud 74–78
  using keys equivalents for 68
Applications
  changing font size and style for 64
  for people with disabilities 65
  for reading 61
  for writing 62–64
  using color for different 63
  using speech options 65
Audio cue for misspelling
  changing 31
  turning off and on 31
  using your own sound 31

B

Background Color
  button 23
  changing 23
  page break effect on 40
Beginning button 14
Beginning command 68
Benefits of Write:OutLoud 8–9
Bitmaps 31, 60

BMP files 31, 60
Bold command 36, 70
Buttons
  in the toolbar 14–23
  key equivalents for 68
  selecting 12

C

Can't find dictionary error message 82
Change button
  in Spelling dialog 50
Changing
  alignment of paragraphs 23, 38–39
  attached Discover setups 77
  audio cue for misspelling 31
  background color 23, 37
  font settings 35
  highlight color 37
  line spacing 40
  option settings 66–67, 67
  paper size and orientation 26
  picture size 35, 57
  pronunciations 45, 71
  speech options 41–45
  text color 23, 37, 68, 70
  text size 35
  voice settings 44, 71
Check Dictionary
  button 19
  command 30
  description of feature 19, 30
  dialog 19, 30, 51, 72
  homonyms 19, 30, 53
  key equivalent for 68, 70
  key equivalents for 72
Check Spelling
  button 18, 49
  command 29, 49, 70
  dialog 29, 49, 72
  key equivalent for 68
  key equivalents for 72
Classroom use of Write:OutLoud 7
Clear command 28, 70
Close command 25, 68
Co:Writer
  can't find speech error 80
  using with Write:OutLoud 80

86  Write:OutLoud  User’s Guide
Color
  applications for using 63
  changing background display 23
  changing text display 23, 37
  contrast for visual needs 65
Communication
  using speech features for 65
Composition step in writing 7
Copy command 27, 70
Cross-platform files. See also Getting Started
  creating 84
  opening on a PC 84, 85
Cue Misspelling
  changing settings 31
  command 31, 70
  description of feature 31
Cursor
  moving within document 14, 33
  using key equivalents to move 68
Cut command 27, 70

D
Default settings
  changing 26, 41
  factory presets 66
  saving 70
Definition. See also Check Dictionary
  checking 19, 30, 52
  for homonyms 19, 30, 53
  for word in question 19, 30, 52
Dictionary
  adding words to WOL User Dictionary 49
  description of feature 19
  educational benefits of 48
  error message 82
  key equivalents for 72
  using dialog for revision 30
Discover setups
  attaching to Write:OutLoud 76–78
  changing attachments 77
  list of included 75
  moving to Discover folder 74
  using with Write:OutLoud 74–78
  where installed 74
Documents
  changing appearance 22–23
  changing background color 23
  changing margins 25, 68
  closing 25, 68
  converting from older versions of Write:OutLoud. See Getting Started
  creating new 24, 68
  cross-platform 84. See also Getting Started
  editing 27–33
  list of open 46
  list of recent 26
  opening 24, 68, 81
  previewing 40
  printing 26, 68
  saving 17, 25, 68
  speaking sentence-by-sentence 16
Double Space command 40

E
Earphones 41, 44
Edit menu
  description of commands 27–33
  key equivalents for 70
Editing text
  description of features 27–33
Educational benefits of Write:OutLoud 48
End button 15
End command 33, 68
Error messages
  can’t find dictionary 82
  can’t find speech with Co:Writer 80
  low memory 82
  undetermined speech 79
Exit command 26

F
Features
  description 12
  overview 5
  tied to educational benefits 8–9
  toolbar 12
File menu
  description of commands 24–26
  key equivalents for 68
  recent files list 26
Find command 28, 70
Find dialog 28, 72
Flashing menu bar
  as visual cue for misspelling 31
  troubleshooting 83
  turning off and on 31
Font
changing color 35
changing size 22, 35, 64
changing style 35, 64
changing type 35
command 35
differences between Mac and PC 84
minimum size allowed 36
options dialog 70
Franklin Dictionary 19, 30
educational benefits of 8
Franklin Spell Checker. See also Check Spelling
educational benefits of 8, 48
using 19, 30, 51

Graphics
adding to document 19–21, 31–32, 56
adding to pictures directory 59
adding your own 56
changing size 22, 57
formats supported 31, 60
samples included with Write:OutLoud 20, 31, 54
space around 55
white space around 80
Grow Selection
button 22, 22–24
command 35, 68, 70

Highlight
entire document 28
next sentence 15
Word by Word command 44
Highlight Word by Word
command 44, 71
educational benefit of 8
effect on performance 44
Homonyms
as suggested words 19, 30
checking in dictionary 19, 30, 52, 70

Installation. See Getting Started. See also READ ME FIRST
Internet files 24
Invisible text 64
Italic command 36, 70

J
JPEG files 31, 60

K
Key equivalents. See also specific command
for alternate access 65, 68
for commands 68
for editing text 71
for File menu 68
for Find dialog 72
for formatting text 70
for highlighting text 69
for speaking text 71
for text navigation 69
for the toolbar 68

L
Launching Write:OutLoud 12
Macintosh 6
Windows 95 & 98 6
Learn button
in Spelling dialog 29, 49
Line spacing
of paragraphs 40
of pictures 55
Low memory error message 82

M
MacinTalk 2
compatibility with Write:OutLoud 81, 82
removing from system 81, 82
Margins 25
Memory
allocating more to Write:OutLoud 82
error message 82
Mispronunciations. See Pronunciations
Misspelling
auditory cue for 31
displayed in Spelling dialog 18, 29, 50
using your own sound file for 31
visual cue for 31
Move button 14
Move command 33
Move to Beginning of Document command 33
Move to End of Document command 33
Move to Next Sentence command 33
Moving cursor 14–24, 33, 69
Index

N
Navigation tools
  buttons in toolbar 14–15
  key equivalents for 69
New command 24, 68

O
OCR software 61
On-screen help 47
Open command 24, 68
Options
  choosing settings 67
  menu 37, 37–41
  saving settings 26, 41, 66–67, 67
  saving settings in a stationery pad or template 66
Organization for writing 7

P
Page breaks
  and printing 40
  effect on background color 40
  hiding 40, 70
  showing 40, 70
Page Setup command 25, 25–26, 68
Paragraph
  alignment 23, 38–39
  line spacing 40
  speaking 43
Paste command 28, 70
Photographs, importing into Write:OutLoud 60
PICT files 31, 60
Pictures
  adding to document 19–21, 31–32, 56
  adding to pictures directory 59
  categories 20, 31, 32, 54, 55, 59
  changing alignment 58
  changing size 35, 57
  formats supported 60
  resizing 22, 57
  samples included with Write:OutLoud 20, 31, 32, 54, 55
  space around 55
  using your own 56
  white space around 80
Planning step in writing 7
Preferences 66–67, 67
Print command 26, 68
Print One
  button 17, 68
  command 26, 68
  description of feature 26
  key equivalent for 68
Print Setup command 26
Printer
  selecting in Print Setup dialog 26
Printing
  documents 26
  options for 26
  with the Print One button 17
Problem-Solving 79–85
Production step in writing process 7
Pronunciations
  changing 45
  command 45, 71
  Exceptions Dictionary 45, 71
  key equivalents for dialog 71
Proper names 45

Q
Quit command 26, 68

R
Read Word Spelling
  in Spelling dialog 50
Reading
  application ideas 61
  sample documents 10
Recent Files list 26
Redo command 27
Regular command 36
Regular Text command 36, 70
Repeat
  button 17
  command 42, 68, 71
Repeat command 42
Resizing
  pictures 22, 57
  text 22, 34–35
Revise for meaning step in writing process 7
Revise for mechanics step for writing 7
Ribbon. See Toolbar
S

Sample files  67
Save As command  25, 68
Save As Default command  26, 41
Save button  17, 68
Save command  25, 68
Saving files for cross-platform use  84
Scaffolding  7
Select All command  28, 70
Select button  15
Select Sentence command  33
Selecting text  33
to change color  37
to change font size  22, 34
to speak  16, 41–45, 42
with key equivalents  69
Sentence
    highlighting next  15, 33, 68
    moving cursor to next  14, 33, 68
    speaking as you type  43
    speaking current  16
    speaking next  16
Set Colors command  37
Setups
    attaching Discover to Write:OutLoud  76
        using Discover with Write:OutLoud  74
Show Page Breaks command  40, 70
Show Toolbar command  37
Shrink Selection
    button  22–24
    command  36, 68, 70
Single Space command  40
Sound cue for misspelling  31
Speak button
    in Dictionary dialog  19
    in Spelling dialog  18, 29, 50
    in toolbar  16
Speak command  42, 68, 71
Speak Letters command  43, 65, 71
Speak Paragraphs command  43, 65, 71
Speak Sentences command  43, 65, 71
Speak Toolbar command  37
Speak Words command  43, 65, 71
Speech
    and highlighted text  44
    can’t find with Co:Writer  80
    changing options  41–45
    description of feature  16–17
    doesn’t match highlight  79
    doesn’t work  79
    feedback for multi-sensory learning  9, 65
    for toolbar buttons  37
    incorrect  79
    interrupting  17, 43
    key equivalents for  71
    menu  41–45
    output for communication  65
    output for special applications  62
    rate  44
    repeating  17, 42
    settings  44
    slow  44
    stopping  17, 43
    turning off  41
    turning on  41
    volume  44
Spell check button  18–47
Spell checker.  See Check Spelling
description of feature  18, 29, 50
dialog  18–47, 49
educational benefits of  48
key equivalent for  68, 70
key equivalents for dialog  72
using  49–51
Spelling
dialog  29
key equivalents for dialog  72
Spelling monitor.  See Cue Misspelling
Steps for writing process  7
Stop button
    in Dictionary dialog  19
    in Spelling dialog  49
    in toolbar  17
Stop Speaking command  43, 71
Stop Speech command  43
Style
    applying to text  70
Suggested words
    in Dictionary dialog  19
    in Spelling dialog  18, 29, 50
T
Talking spell checker and dictionary 48–53
Templates
sample files included 10–12, 67
Text
appearance 22–23, 34–36
changing color 23, 37
changing line spacing 40
changing size 35
checking spelling 72
editing 71
finding specific words 72
formatting with key equivalents 70
highlighting 28, 44, 69
invisible 64
making formatting changes to 34
navigating 14–15
selecting 14–15, 28
selecting for speech options 16–17
speaking 42, 71
Text Color button 23
Text files
opening in Write:OutLoud 24, 61
saving as 25, 61
scanning in 61
Text menu
description of commands 34–36
Toolbar. See also Getting Started
description 12
displaying 37
educational benefits 9
hiding 37, 83
key equivalents for 68
speaking buttons in 37
Tools
Toolbar buttons defined 12
Transferring files across platforms. See Getting Started
Triple Space command 40
Troubleshooting 79
alignment 80
can’t see text 81
extra white space 80
flashing menu bar 83
low memory error message 82
MacinTalk 2 voices 81
pictures 80
toolbar 83
wrong content in documents 81
Turn Speech Off command 41, 71
Turn Speech On command 41
Tutorial. See Getting Started
U
Underline command 36, 70
Undetermined speech error 79
Undo command 27, 70
V
Vision
option settings to aid 65
Voice settings 44, 71
command 44, 71
key equivalents for 71
W
Windows menu 46
Words
abbreviations for 73
changing color 37, 63, 68, 70
changing misspelled 50
definitions for 19, 30, 52
homonyms for 19, 30, 53
invisible 64
mispronounced 71, 79
misspelled 18, 29, 50
setting speech options for 41–45
suggested 29
Writing
application ideas 62–64
sample documents 11
Writing process, the 7
Limited Warranty

Don Johnston Incorporated warrants Write:OutLoud software for one year from date of purchase. This warranty is valid against manufacture defects and malfunctions not the result of abuse or mishandling. Except for the above, Don Johnston makes no warranties, express or implied, including warranties as to the merchantability or as to the fitness of this product for any particular purpose, and shall not be liable for any loss or damage, directly or indirectly, arising from the use of this software product or for consequential damages.

Don Johnston reserves the right to make any changes, additions, or improvements to the Write:OutLoud software or documentation at any time without notice to any person or organization.

The Write:OutLoud manuals and the software described in them are copyrighted, with all rights reserved. Under the copyright laws, the manuals or the software may not be copied, in whole or part, without written consent of Don Johnston, except in the normal use of the software. The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the original. This exception does not allow copies to be made for others, whether or not sold, but all the material purchased (with all backup copies) may be sold, given or loaned to another person. Under the law, copying includes translating into another language or format.

You may use the software on any computer owned by you, but extra copies cannot be made for this purpose.

DON JOHNSTON'S LICENSOR(S) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE SOFTWARE. DON JOHNSTON’S LICENSOR(S) DOES NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME JURISDICTIONS. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL DON JOHNSTON’S LICENSOR(S), AND THEIR DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS (COLLECTIVELY DON JOHNSTON’S LICENSOR) BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF DON JOHNSTON’S LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. Don Johnston’s Licensor’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort [including negligence], product liability or otherwise), will be limited to $50.